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1. Introduction
This user manual describes how to use the e-SAFETY Application. The 
application is a web-based application used to gather safety inspection data that 
will then be used by the Pennsylvania Department of Transportation 
(PennDOT) to analyze trends. These trends will be used to look for ways to 
reduce inspection fraud, discover safety equipment repair trends, become more 
proactive in safety recalls, ensure proper inspections and monitor employee 
and/or contractor performance.

This manual includes the following sections:

• “Getting Started”

• “Viewing Messages”

• “Entering Safety Data”

• “Maintaining Sticker Inventory”

• “Navigating PennDOT Bulletins”

• “Report Basics”

• “Report Descriptions”

• “Application Administration”

• “Third Party Data File Upload”

• “Self Enrollment”

The application is “browser-based,” meaning that the application is run using 
the Internet browser already installed on your computer. If you do not have an 
Internet browser, or if you are not sure how to use the Internet browser, please 
contact your manager or supervisor to help get you started.

The following sections are contained within this chapter:

• “About this Manual”  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 8

• “Typographic Conventions”  . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 9

• “About the Interface” . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 10

• “Software and Hardware Requirements”  . . . . . . . . . . . . . . . . . . . .  page 11

• “Required Hardware and Software” . . . . . . . . . . . . . . . . . . . . .  page 11

• “Recommended Hardware and Software”  . . . . . . . . . . . . . . . .  page 11
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About this Manual
This manual describes how to use the e-SAFETY Application. It consists of the 
chapters described in the following table.

Chapter Description

“Introduction” Provides an overview of the application and describes 
the text conventions used in this manual. This chapter 
also contains system requirements.

“Getting Started” This chapter provides instructions for browsing to the 
application, logging into it and logging out of it. This 
chapter begins on page 13.

“Viewing Messages” This chapter provides instructions for viewing 
PennDOT Messages. These messages contain 
information about the status of the e-Safety program. 
This chapter begins on page 27.

“Entering Safety Data” This chapter provides detailed information about 
entering safety data that is collected during an 
inspection.This chapter begins on page 33.

“Maintaining Sticker Inventory” This chapter provides detailed information about 
maintaining safety sticker data. This chapter begins 
on page 57.

“Navigating PennDOT Bulletins” This chapter provides detailed information about 
navigating to external PennDOT safety bulletins. This 
chapter begins on page 69.

“Report Basics” This chapter provides general information about how 
to run, navigate, print, save and export reports. This 
chapter begins on page 71.

“Report Descriptions” This chapter provides detailed information about each 
of the safety data reports. This chapter begins on 
page 83.

“Application Administration” This chapter provides detailed information about 
maintaining application user login information and 
passwords. This chapter begins on page 103.

“Third Party Data File Upload” This chapter provides detailed information about 
uploading third party safety data files. This chapter 
begins on page 109.

“Glossary” This chapter provides a list of terms, acronyms and 
definitions for keys words used in this user manual. 
This chapter begins on page 117.
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Typographic Conventions
Certain type styles are used to make the information in this manual clear and 
easy to identify and understand.

Following are descriptions and examples of the typographic conventions used in 
this manual:

NOTE: Look for 
important notes 
and tips that are 
set apart from the 
rest of the text, 
like this.

• Words in Italics indicate the name of a field or screen. For example: 
Enter your password in the Password field.

• Words in Bold indicate the name of a button, menu name or menu 
option. For example: Click Save PDF to save the selected report as a 
PDF.

• Words that are Underlined indicate the name of a link that when clicked, 
displays additional information or opens another screen. For example: 
Click the Download link to display the Download Report screen.

• When instructions tell you to select a command from the menu bar, it is 
shown in bold type with a “greater than” sign between the menu 
commands in hierarchal order. For example: Choose File > Print from 
the menu bar.
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About the Interface
Because this application is browser-based, you navigate and operate the 
application much the same as you would navigate and operate a browser while 
using the Internet.

This manual assumes that you already know how to carry out basic computer 
skills, such as clicking a button on the screen. For additional instructions in 
these skills, consult your computer’s online help or the user manual that came 
with the computer.
- 10 -
Application Solutions

July 9, 2008 1:33 pm TDG



Software and Hardware Requirements

Pennsylvania e-SAFETY Program
e-SAFETY Application User Manual

Doc Ver 5.00 / App Ver 3.07.01
Software and Hardware Requirements
This section describes the minimum software and hardware requirements 
necessary to run the e-SAFETY Application. This section also lists recommended 
hardware and software that will improve the user experience.

Required Hardware and Software
The minimum software and hardware requirements are:

• Desktop or laptop computer with Pentium processor or equivalent

• 128 megabytes (MB) of random access memory (RAM)

• Microsoft Windows operating system

• Desktop resolution set to 800 x 600

• Microsoft Internet Explorer 6.0 or higher / Firefox 1.5 or higher

• Adobe Acrobat Reader 6.0 or higher

• JavaScripting enabled

• Internet cookies enabled

Recommended Hardware and Software
The recommended software and hardware requirements are:

• 256 megabytes (MB) of random access memory (RAM)

• Desktop resolution set to 1024 x 768 for best results

• Microsoft Excel (for viewing saved report data)

• 2D Barcode scanner that can decode standard PDF-417 encoding 
symbology
- 11 -
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2. Getting Started
This chapter provides instructions for connecting to the Safety Inspection 
Identification Database (SIID), browsing to the application, logging in and 
exiting.

You can access the e-SAFETY Application through your own Internet Service 
Provider (ISP) or through a toll free dial-up connection.

TIP: Before get-
ting started, 
check to make 
sure that an Inter-
net browser is 
installed and 
operating on your 
computer. If you 
need help with 
this, see your 
manager or 
supervisor.

To successfully log into the application, you must have a valid user name and 
password. If you do not, see your manager or supervisor.

This section covers the following topics:

• “Accessing the Application”. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 14

• “Connecting Through Your Own ISP” . . . . . . . . . . . . . . . . . . .  page 14

• “Connecting Through the Toll Free Number”  . . . . . . . . . . . .  page 16

• “Logging into the Application”  . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 18

• “Reloading Web Pages” . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 19

• “Exiting the Application”  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . page 21

• “Changing Internet Explorer Settings” . . . . . . . . . . . . . . . . . . . . .  page 22

• “Troubleshooting Login” . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 26
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Accessing the Application
The following instructions describe how to connect to the internet through your 
own ISP, connect through the toll free number, log into the application, log out 
of the application and exit the application.

Be sure that you have an Internet browser set up on your computer before 
starting the application. Contact your manager or supervisor if you do not have 
an Internet browser.

Connecting Through Your Own ISP
If you already have an internet connection provided by your own ISP, you can 
connect to the e-SAFETY Application the same way you would to view any other 
web site. If you do not have an ISP providing and internet connection, you can 
connect using a toll free dial-up number. See “Connecting Through the Toll Free 
Number” on page 16 for more information.

NOTE: Contact 
your ISP if you 
are experiencing 
connections 
issues.

To Connect Through Your Own ISP
1. Turn on your computer and wait for Microsoft Windows to start. It is 

ready when the mouse pointer changes from an hourglass to an arrow.

2. Start your internet connection as you would to access any other web site.

Some broadband or DSL connections are considered “always on”. This 
indicates that as long as your computer is on, a connection to the internet 
is made. If you have an “always on” connection, you do not need to 
perform this step.

3. Open your Internet browser. 

If you are using Internet Explorer as your browser: From the Windows 
Start menu, choose (All) Programs > Internet Explorer.

4. Type the URL for the application in the Address field of the Internet 
browser and press Enter.

NOTE: The Web 
address is also 
known as a Uni-
form Resource 
Locator (URL).

5. The Safety Station User Login screen appears, as shown in Figure 1.
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Figure 1:  Safety Station User Login Screen

6. To log into the application, proceed to the section “Logging into the 
Application” on page 18.
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Connecting Through the Toll Free Number
A toll free dial up number has been provided for users who do not have their own 
internet connection. This dial-up connection will allow you to access the e-
SAFETY Application. However, no other web sites can be accessed while 
connected through this number.

To Connect Through the Toll Free Number
You must first set up your computer to dial into the e-SAFETY Application. 
Because the steps for setting up a dial-up connection is different between 
operating systems, you will need to consult your computer’s user manual for 
assistance with this.

The toll free dial-up number to connect to the e-SAFETY Application is 1-866-
402-0749.

1. Turn on your computer and wait for Microsoft Windows to start. It is 
ready when the mouse pointer changes from an hourglass to an arrow.

NOTE: The Web 
address is also 
known as a Uni-
form Resource 
Locator (URL).

2. Start the toll free dial-up connection and wait for the process to be 
complete.

3. Open your Internet browser. 

If you are using Internet Explorer as your browser: From the Windows 
Start menu, choose (All) Programs > Internet Explorer.

4. Type the URL for the application in the Address field of the Internet 
browser and press Enter.

5. The Safety Station User Login screen appears, as shown in Figure 2.
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Figure 2:  Safety Station User Login Screen

6. To log into the application, proceed to the section “Logging into the 
Application” on page 18.
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Logging into the Application
The following instructions describe how to log into, log out of and exit the 
application. Be sure that you have an Internet browser set up on your computer 
before starting the application. Contact your manager or supervisor if you do not 
have an Internet browser.

You must log in before you can start using the e-SAFETY Application. At login, 
the application verifies your identity, checks to see what parts of the application 
you can access and connects to the database.

WARNING: The 
application will 
time-out after 10 
minutes of inac-
tivity. Any 
unsaved informa-
tion will be lost.

If your login fails, check the information entered into the text fields and try 
retyping the text. If you still cannot log in, contact your manager or supervisor.

To Log Into the Application
1. Access the application. For more information see “Accessing the 

Application” on page 14.

2. Enter your Station ID, User ID and Password in the fields provided in the 
Safety Station User Login screen, as shown in Figure 3.

Figure 3:  Safety Station User Login Screen

3. Click Login.

The application verifies your entries and connects to the system.
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When the application successfully connects, a screen containing the 
available links displays, as shown in Figure 4.

Figure 4:  Main Application Menu Screen

Once logged in, the application is ready to record safety inspections. See 
“Entering Safety Data” on page 34 for more information.

Reloading Web Pages
To be sure that you are viewing current information, you can set your Internet 
browser to always display the latest version of a screen. To do this, you select 
options in the Internet browser so that web pages are reloaded every time you 
open a new screen.

The procedure detailed here is for Microsoft Internet Explorer. If you are using a 
different web browser, such as Netscape or Firefox, please consult their user’s 
guide for instructions on how to set this up.

To Reload Web Pages on Every Visit
1. Select Tools > Internet Options from the Internet Explorer menu bar. 

The Internet Options window appears, as shown in Figure 5.
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Figure 5:  Internet Options Window

2. Click Settings... in the Temporary Internet files section. The Settings 
window appears, as shown in Figure 6.

Figure 6:  Settings Window

3. Select the Every visit to the page option.

4. Click OK to save the changes and return to the Internet Options window.

5. Click OK to exit the Internet Options window.
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Exiting the Application
When you are ready to quit, or want to let another user log into the application, 
you must log out of the application. Logging out ensures that the application is 
no longer connected to the server and that no unauthorized users can enter or 
view customer data.

WARNING: The 
application will 
time-out after 10 
minutes of inac-
tivity. Any 
unsaved informa-
tion will be lost.

To Log Out and Exit the Application
1. Click Logout in the upper-right area of the screen.

2. In Internet Explorer, choose File > Close from the browser’s menu bar.

Or

Click the Close ( ) button at the top right of each screen’s title bar.

The next user can now access the application and log into it.
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Changing Internet Explorer Settings
The e-SAFETY Application has been developed to run with the default Internet 
Explorer settings. If some of these settings are changed, they can make the 
application inoperable.

To Enable JavaScripting
If the application is not running properly, check the JavaScript settings from 
Internet Explorer.

TIP: Depending 
on the policy of 
your business, 
you may not have 
the appropriate 
permissions to 
make changes to 
your browser set-
tins. Contact your 
shop manager or 
system adminis-
trator to have 
these changes 
made.

1. Select Tools > Internet Options... from the browser's menu. The Internet 
Options window is displayed, as shown in Figure 7.

Figure 7:  Internet Options Window

2. Select the Security tab.

3. Click Custom Level....

4. Scroll down to the Scripting section, as shown in Figure 8.
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Figure 8:  Security Settings Screen

5. Make sure that Active scripting is enabled.

TIP: Your browser 
stores many of its 
settings. The best 
way to ensure 
this change has 
taken effect is to 
close all browser 
windows com-
pletely, then 
relaunch it. 

6. Click OK to accept the setting changes.
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To Enable Internet Cookies
Internet cookies are small text files saved on a local machine to store session 
data. The internet cookies setting must be set in order to use the e-SAFETY 
Application.

1. Select Tools > Internet Options... from the browser's menu. The Internet 
Options window is displayed, as shown in Figure 9.

Figure 9:  Internet Options Window

2. Select the Privacy tab as shown in Figure 10.
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Figure 10:  Privacy Settings Screen

3. Move the settings slider to be at least Medium, as shown in Figure 10. 
The privacy levels of Low or Accept All Cookies will also work.

4. Make sure that Active scripting is enabled.

NOTE: Your 
browser stores 
many of its set-
tings. The best 
way to ensure 
this change has 
taken effect is to 
close all browser 
windows com-
pletely, then 
relaunch it. 

5. Click OK to accept the setting changes.
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Troubleshooting Login
If you still cannot log in after trying the following troubleshooting tips, contact 
your manager or supervisor.

If your login attempt fails:

• Verify that the correct station ID was entered.

• Double-check your user ID and password and reenter the information.
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3. Viewing Messages
Periodically, messages created by the Pennsylvania Department of 
Transportation (PennDOT) are sent to testing stations. These messages can 
include information about safety information, recall notices, changes in policy, 
license renewal notices, notices to inspectors and owners and other related 
information.

These messages can be sent to either a single station or a group of stations. The 
system will receive the message the next time it connects to Pennsylvania's 
Electronic Emissions Transmission Service. The message will be uploaded from 
the Safety Inspection Identification Database (SIID) and will be viewed through 
the e-SAFETY Application.

Messages will be viewed by each user until they have been removed by the 
personnel at the station who has manager rights in the application. Only 
personnel with the application role of supervisor can remove messages.

The following sections are contained within this chapter:

• “Viewing PennDOT Messages”  . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 28

• “Printing PennDOT Messages”  . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 30

• “Removing PennDOT Messages” . . . . . . . . . . . . . . . . . . . . . . . . . . . page 31
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Viewing PennDOT Messages
When you log into the e-SAFETY Application, the PennDOT Messages/Bulletins 
screen is displays any messages that have been sent to the station. Messages will 
automatically display at login until they have been removed by the station 
manager. PennDOT bulletins can be viewed using the Safety Bulletins links. See 
“Navigating to PennDOT Bulletins” on page 70 for more information.

WARNING: Only 
personnel with 
manager or 
supervisor privi-
leges can remove 
a message.

To View PennDOT Messages and Bulletins
1. Log into the e-SAFETY Application. See “Logging into the Application” 

on page 18 for more information. 

The PennDOT Messages/Bulletins screen is shown if any messages are 
available to be read, as shown in Figure 11. 

Figure 11:  PennDOT Messages/Bulletins Screen

The following table provides details about each field:

Field Name Description

Message The system-assigned number for the message.

Date The date when the message was sent by PennDOT.

From The name of the person or group who sent the message.

Subject The subject line is generally a short sentence that describes the 
overall message topic.

Body The body section displays the entire text of the message.

Select This check box is used to select the message(s) to be printed or 
removed. See “Printing PennDOT Messages” on page 30 and 
“Removing PennDOT Messages” on page 31 for more 
information.
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2. The messages can be printed or removed. See “Printing PennDOT 
Messages” on page 30 and “Removing PennDOT Messages” on page 31 
for more information.
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Printing PennDOT Messages
A PennDOT message can be printed from the e-SAFETY Application if a printer 
is attached to the computer.

To Print PennDOT Messages
1. Once one or more messages are displayed, they can be printed for future 

use. See “Viewing PennDOT Messages” on page 28 for more information 
about viewing messages. 

2. Choose the Select check box for each message you want to print.

3. Click Printable View.

The message is displayed in a separate print screen, as shown in Figure 
12.

Figure 12:  PennDOT Messages/Bulletins Print Screen

4. Click Print. The standard Windows print screen is displayed.

5. Click OK to print the selected message(s).

6. Close the print screen to return to the main e-SAFETY Application 
screen.
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Removing PennDOT Messages
A PennDOT message can be removed once it has been read. Removing a message 
can only be done by personnel with manager or supervisor privileges. The 
message will continue to be displayed at each login until the message has been 
removed.

To Remove PennDOT Messages
1. Once one or more messages are displayed and read, they can be removed. 

See “Viewing PennDOT Messages” on page 28 for more information 
about viewing messages. 

WARNING: Only 
personnel with 
the manager or 
supervisor privi-
leges can remove 
a message.

2. Choose the Select check box for each message you want to remove.

3. Click Remove.

4. A message screen is displayed confirming that you want to remove this 
message. Click OK. 

5. The application prompts that the message was successfully removed.
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4. Entering Safety Data
The e-SAFETY Application is used to gather safety inspection data to be used by 
the Pennsylvania Department of Transportation (PennDOT) to analyze trends 
within safety criteria and look for ways to reduce inspection fraud, discover 
safety equipment repair trends, become more proactive in safety recalls, ensure 
proper inspections and monitor employee and/or contractor performance.

Information is collected through application screens that are similar to the 
paper-based forms (MV-431 and MV-480) provided by the state for safety 
inspections. This information is then stored in a database that can be accessed by 
PennDOT personnel.

Data is collected for safety inspections of passenger vehicles, motorcycles, trucks 
and trailers. The entry screens for these three inspections are primarily the 
same. However, some fields will be disabled when they do not apply to a 
particular vehicle inspection type.

The following sections are contained within this chapter:

• “Entering Safety Data”. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 34

• “Safety Inspection Information” . . . . . . . . . . . . . . . . . . . . . . .  page 37

• “Using the Barcode Scanner”  . . . . . . . . . . . . . . . . . . . . . . . . .  page 49

• “Completing/Finalizing Entered Safety Data” . . . . . . . . . . . .  page 50

• “Canceling a Safety Inspection”  . . . . . . . . . . . . . . . . . . . . . . .  page 50

• “Working With Pending Work Orders” . . . . . . . . . . . . . . . . . . . . . . page 51
- 33 -
Application Solutions

July 9, 2008 1:33 pm TDG



Entering Safety Data

Pennsylvania e-SAFETY Program
e-SAFETY Application User Manual

Doc Ver 5.00 / App Ver 3.07.01
Entering Safety Data
The e-SAFETY Application is a web-based application that is used to collect 
safety inspection data. The Safety Inspection screen is an online version of the 
paper forms (MV-431 and MV-480) used for safety inspections. The MV-431 or 
MV-480 form is used depending on the vehicle type being inspected. 

NOTE: The 
inspection type of 
Reconstructed/
Specially Con-
structed is used 
for vehicles that 
have received 
major work or 
have been built 
from scratch. 
These vehicles 
have not received 
PENDOT regis-
tration.

The following table lists the vehicle types.

The Safety Inspection screen will display all of the same entry fields regardless of 
the inspection vehicle type. However, depending on the type, certain fields will 
become disabled if they are not needed. The Safety Inspection screen for 
passenger car is shown in Figure 13.

Form Used When

MV-431 Vehicle Type:

• Passenger Car

• Light Truck

• Medium Truck

• Heavy Truck

• Bus

• School Bus

• Motor Home

• Reconstructed/Specially Constructed

MV-480 Vehicle Type:

• Motorcycle/Motor-Driven Cycle

• Moped/Motorized Pedal-Cycle

• Trailer

• Reconstructed/Specially Constructed
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Figure 13:  Safety Inspection Screen

Because there are a large number of data entry fields, the screen is described in 
this manual into three major sections: general vehicle information station, 
vehicle and owner information), test results and safety sticker information. See 
“To Enter Inspection, Owner and Vehicle Data” on page 38, “To Enter Safety 
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Inspection Results Data” on page 43 and “To Enter Safety Sticker Data” on 
page 47 for details about each section.
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Safety Inspection Information
You must first enter basic owner and vehicle information before you begin 
recording safety inspection results using the e-SAFETY Application. 

You can perform an inspection on passenger vehicles, trucks, buses, recreational 
vehicles, motorcycles, mopeds or trailers. See the table in the section “Entering 
Safety Data” on page 34 for a detailed list of vehicle types. The screens for each 
of these vehicle types are primarily the same.

The passenger vehicle safety inspection uses all available fields in the Safety 
Inspection screen. All fields are used for the other inspection types unless noted.

A safety inspection can be started and marked as pending to be finalized at a 
later time. 

The following fields must be entered for the system to accept the inspection as 
pending. These fields are noted with an asterisk (*).

• Inspection Number

• Work Order

• Inspection Date

• Last Name

• Vehicle Identification Number (VIN)

• Plate Number

See “To Enter Inspection, Owner and Vehicle Data” on page 38 for more 
information about required fields.
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To Enter Inspection, Owner and Vehicle Data
1. Select New Inspection > MV431 or MV-480 from the main application 

menu and select the vehicle type. See the table in the section “Entering 
Safety Data” on page 34 for a detailed list of vehicle types. The Safety 
Inspection screen appears, as shown in Figure 14. 

NOTE: Fields 
marked with an 
asterisk (*) must 
be filled in before 
saving an inspec-
tion as pending. 
Fields that have 
an underlined 
description are 
fields that will 
populate when 
scanning a bar-
code.

Figure 14:  Safety Inspection Screen

2. The following fields are auto-populated by the application:

3. Enter the preliminary safety inspection information.

Field Name Description

Vehicle Category System-provided field defining the vehicle type. For 
example: passenger vehicle, motorcycle or trailer. 
This field cannot be edited.

System Record No System-provided number. This number will be 
populated when the inspection is marked as Final or 
as Keep Pending. This field cannot be edited.
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The following table provides details about each field:

4. Enter the vehicle registrant (owner) information.

TIP: The  is 
used for changing 
a field from a 
type-in field to a 
list box.

The following table provides details about each field:

Field Name Description

Annual / Semi Annual / One-
Time

Select whether the test type is an annual, semi annual 
or one-time only safety inspection.

Annual and Semi Annual inspections are directly 
related to the inspection types of the same name in 
the PennDOT Vehicle Equipment and Inspection 
Regulations Manual. One-Time inspections are for 
Reconstructed/Specially Constructed vehicles.

Work Order Enter the 10-digit alphanumeric work order number 
from the form. This is a required field when saving an 
inspection as pending.

Inspector Lic ID Enter the ID number for the person who performed the 
safety inspection.

Inspection Date Enter the date that the inspection took place in a mm/
dd/yyyy format. You can also click on the Calendar 
icon to select the date. This is a required field when 
saving an inspection as pending.

Field Name Description

Last Name / Company 
Name

Enter the last name of the registered owner of the 
vehicle. This field can be filled in automatically by 
using a barcode scanner. See “Using the Barcode 
Scanner” on page 49 for more information. This is a 
required field when saving an inspection as pending. 
When entering a company name, the First Name field 
is not used.

First Name Enter the first name of the registered owner of the 
vehicle. This field can be filled in automatically by 
using a barcode scanner. See “Using the Barcode 
Scanner” on page 49 for more information.

City Enter the city where the vehicle is registered. This 
field can be filled in automatically by using a barcode 
scanner. See “Using the Barcode Scanner” on 
page 49 for more information.

State Select the state from the list box for the registered 
vehicle owner. The default for this field is 
Pennsylvania.

ZIP Code Enter the five-digit ZIP Code for the registered vehicle 
owner.
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5. Enter the vehicle insurance information.

The following table provides details about each field:

6. Enter the vehicle identification information.

TIP: The  is 
used for changing 
a field from a 
type-in field to a 
list box.

The following table provides details about each field:

County Enter the county where the vehicle is registered or 
select from the list box. This field can be filled in 
automatically by using a barcode scanner. See “Using 
the Barcode Scanner” on page 49 for more 
information.

Field Name Description

Company Enter the name of the insurance company for which 
the owner has a valid policy. Click the icon to the right 
of this field for a list of many of the available insurance 
companies. This field is not available for trailers, 
reconstructed and specially constructed vehicles.

NAIC No The five digit National Association of Insurance 
Commissioners (NAIC) number associated with the 
registered vehicle owner's insurance company. This 
field is not available for trailers, reconstructed and 
specially constructed vehicles.

Policy No Enter the alphanumeric insurance policy ID assigned 
with the registered vehicle owner by their insurance 
company. This field is not available for trailers, 
reconstructed and specially constructed vehicles.

Expires (mm/dd/yyyy) Enter the expiration date of the insurance policy for 
this vehicle. This date is entered in a mm/dd/yyyy 
format. This field is not available for trailers, 
reconstructed and specially constructed vehicles.

Field Name Description

Field Name Description

VIN No Enter the vehicle identification number (VIN) for this 
vehicle. This number consists of 17 alphanumeric 
characters (21 for previously salvaged vehicles). This 
field can be filled in automatically by using a barcode 
scanner. This is a required field when saving an 
inspection as pending (except for reconstructed and 
specially constructed vehicles). Enter TBI (To Be 
Issued for these vehicles).
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7. Scroll to the bottom of the page and click Keep Pending to save the 
entered information.

Retype VIN Re-type the VIN for this vehicle. This field is not 
required if the vehicle information was captured with 
the barcode scanner or for reconstructed and 
specially constructed vehicles. See “Using the 
Barcode Scanner” on page 49 for more information on 
scanning or enter TBI (To Be Issued for reconstructed 
and specially constructed vehicles).

Plate No Enter the registered license plate number for the 
vehicle. This field can be filled in automatically by 
using a barcode scanner. This is a required field when 
saving an inspection as pending (except for 
reconstructed and specially constructed vehicles).

Old Odometer Enter the odometer reading that was captured during 
the previous safety inspection. This field is not 
available for trailers, motorcycles or motor driven 
cycles.

Click the icon to the right of this field for a drop-down 
list of available alternate entries (Out of State, No 
Previous Sticker, Unreadable and N/A).

For Reconstructed and Specially Constructed 
Vehicles, the drop-down choices are; Recon, Specon 
and Modify.

Current Odometer Enter the current odometer reading at the time the 
safety inspection occurred. This field is not available 
for trailers.

Click the icon to the right of this field for a drop-down 
list of available alternate entries (Non-Functional and 
Exempt).

Model Year Enter the numeric model year for the registered 
vehicle. This number is entered in a yyyy format. This 
field can be filled in automatically by using a barcode 
scanner. See “Using the Barcode Scanner” on 
page 49 for more information.

Make Enter the auto manufacturer information. This field 
can be filled in automatically by using a barcode 
scanner. See “Using the Barcode Scanner” on 
page 49 for more information.

Body Select the vehicle body style from the drop-down list.

Color Select from the list box the primary color of the 
vehicle.

Field Name Description
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NOTE: Once you 
click Keep Pend-
ing, the safety 
inspection can 
only be accessed 
from the Pending 
Work Orders 
screen. See, “To 
View Pending 
Work Orders” on 
page 51 for more 
information.

Or

Start the safety inspection. See “To Enter Safety Inspection Results Data” 
on page 43 or “Working With Pending Work Orders” on page 51 for more 
information.
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To Enter Safety Inspection Results Data
1. Start a new safety inspection by entering the preliminary safety 

information, registrant, vehicle insurance and vehicle information. See 
“To Enter Inspection, Owner and Vehicle Data” on page 38 for more 
information.

NOTE: Some 
data is not col-
lected for certain 
vehicle types. In 
Internet Explorer, 
the field will be 
un-editable. In 
Firefox, the field 
is shaded as well 
as being un-edit-
able.

2. Enter the safety test results in the Test Results section of the screen, as 
shown in Figure 15.

Figure 15:  Test Results and Visual Anti-Tampering Results Screen
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The following table provides details about each field:

Field Name Description

Lowest Tire Reading Enter the value of the tire tread measurement with the 
lowest reading.

Select the side that the tire is located:

• Left

• Right

• Middle

Select the axle location:

• Front

• Middle

• Rear

Select the wheel location:

• Inner

• Outer

• Single

FRONT Brake Enter front brake measured thickness (in 32nd of an 
inch).

Select the side that the brake is located:

• Left

• Right

• Middle

Select the brake lining type:

• Riveted

• Bonded

• Bolted

REAR Brake Enter rear brake measured thickness (in 32nd of an 
inch).

Select the side that the brake is located:

• Left

• Right

• Middle

Select the brake lining type:

• Riveted

• Bonded

• Bolted

Tires & Wheels Select the best value from the inspection result 
choices: Pass, New, Fail, Adjust, Repair or N/A (not 
applicable). Enter the cost to repair without tax 
included. Enter any comments related to this 
inspection or repair.
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Steering & Suspension Select the best value from the inspection result 
choices: Pass, New, Fail, Adjust, Repair or N/A (not 
applicable). Enter the cost to repair without tax 
included. Enter any comments related to this 
inspection or repair.

Exhaust System Select the best value from the inspection result 
choices; Pass, New, Fail, Adjust, Repair or N/A (not 
applicable). Enter the cost to repair without tax 
included. Enter any comments related to this 
inspection or repair. This field is not available for 
trailers.

Fuel System Select the best value from the inspection result 
choices; Pass, New, Fail, Adjust, Repair or N/A (not 
applicable). Enter the cost to repair without tax 
included. Enter any comments related to this 
inspection or repair. This field is not available for 
trailers.

Glazing & Mirrors Select the best value from the inspection result 
choices; Pass, New, Fail, Adjust, Repair or N/A (not 
applicable). Enter the cost to repair without tax 
included. Enter any comments related to this 
inspection or repair.

Lights, Wiring & Switches Select the best value from the inspection result 
choices; Pass, New, Fail, Adjust, Repair or N/A (not 
applicable). Enter the cost to repair without tax 
included. Enter any comments related to this 
inspection or repair.

Body, Door & Latches Select the best value from the inspection result 
choices; Pass, New, Fail, Adjust, Repair or N/A (not 
applicable). Enter the cost to repair without tax 
included. Enter any comments related to this 
inspection or repair.

Brake Systems Select the best value from the inspection result 
choices; Pass, New, Fail, Adjust, Repair or N/A (not 
applicable). Enter the cost to repair without tax 
included. Enter any comments related to this 
inspection or repair.

Other The other category is used to record any other safety 
issues observed by the technician. Select the best 
value from the inspection result choices: Pass, New, 
Fail, Adjust, Repair or N/A (not applicable). Enter the 
cost to repair without tax included. Enter any 
comments related to this inspection or repair.

Road Test Select Pass or Fail to record the results of the road 
test. This field is not active for reconstructed or 
specially constructed vehicles. Enter any comments 
related to this inspection or repair.

Field Name Description
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3. Enter the visual anti-tampering results in the Visual Anti-Tampering 
Results section, as shown in Figure 15.

NOTE: Once you 
click Keep Pend-
ing, the safety 
inspection can 
only be accessed 
from the Pending 
Work Orders 
screen. See, “To 
View Pending 
Work Orders” on 
page 51 for more 
information.

The following table provides details about each field:

4. Click Keep Pending to save the entered information.

Or

Registration/Ownership 
Verified

Select Yes or No to acknowledge if the registration or 
ownership was verified. This field is disabled for 
reconstructed and specially constructed vehicles.

Subtotal A ($) The dollar total of all repairs made in this section of 
the inspection screen.

Field Name Description

Field Name Description

Catalytic Converter Select the best value from the inspection result 
choices: Pass, New, Fail, Adjust, Repair or N/A (not 
applicable). Enter the cost to repair without tax 
included. Enter any comments related to this 
inspection or repair.

Fuel Inlet Restrictor Select the best value from the inspection result 
choices: Pass, New, Fail, Adjust, Repair or N/A (not 
applicable). Enter the cost to repair without tax 
included. Enter any comments related to this 
inspection or repair.

PCV Valve Select the best value from the inspection result 
choices: Pass, New, Fail, Adjust, Repair or N/A (not 
applicable). Enter the cost to repair without tax 
included. Enter any comments related to this 
inspection or repair.

EGR Valve Select the best value from the inspection result 
choices: Pass, New, Fail, Adjust, Repair or N/A (not 
applicable). Enter the cost to repair without tax 
included. Enter any comments related to this 
inspection or repair.

Air Pump Select the best value from the inspection result 
choices: Pass, New, Fail, Adjust, Repair or N/A (not 
applicable). Enter the cost to repair without tax 
included. Enter any comments related to this 
inspection or repair.

Evaporative Control System Select the best value from the inspection result 
choices: Pass, New, Fail, Adjust, Repair or N/A. Enter 
the cost to repair without tax included. Enter any 
comments related to this inspection or repair.

Subtotal B ($) The dollar total of all repairs made in this section of 
the inspection screen.
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Complete the safety inspection. See “To Complete Entered Safety Data” 
on page 50 or “Working With Pending Work Orders” on page 51 for more 
information.

To Enter Safety Sticker Data
A safety inspection sticker can be issued once all safety inspection information 
has been gathered. A sticker number, expiration date and customer cost 
information should be entered in the Safety Sticker section of the screen.

NOTE: Some 
data is not col-
lected for certain 
vehicle types. In 
MS Internet 
Explorer, the field 
will be unedit-
able. In Firefox, 
the field is 
shaded as well as 
being un-edit-
able.

1. Enter the general inspection, owner and vehicle information and safety 
inspection data. See “To Enter Inspection, Owner and Vehicle Data” on 
page 38 and “To Enter Safety Inspection Results Data” on page 43 for 
more information.

A safety sticker can be issued once the vehicle has passed the inspection.

2. Enter the sticker information in the Safety Sticker section of the screen, 
as shown in Figure 16. 

Figure 16:  Safety Sticker Section

WARNING: The 
Sticker No prefix 
cannot be an “IM” 
designation. This 
is for emissions 
stickers only.

The following table provides details about each field:

3. Enter the cost information in the Safety Sticker section of the screen.

Field Name Description

Sticker No Enter the 10 character alphanumeric sticker number in 
a XX99999999 format where XX is AI, AO or SI (no 
other sticker prefix is valid).

If the safety inspection resulted in a fail to pass, enter 
FAIL.

Expiration (MM/YYYY) Enter the month and year that the safety sticker will 
expire. The month should be designated with a two 
character entry. For example, July = 07. The year 
entry should be entered in a YYYY format.

The expiration date must not be less than six months 
and no more than 15 months after the current 
calendar year.
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The following table provides details about each field:

4. Click Keep Pending to save the entered information. See “Working With 
Pending Work Orders” on page 51 for more information.

NOTE: Once you 
click Keep Pend-
ing, the safety 
inspection can 
only be accessed 
from the Pending 
Work Orders 
screen. See, “To 
View Pending 
Work Orders” on 
page 51 for more 
information.

Or

Click Final to save the entered information and mark the inspection as 
complete.

A message indicating that the save was successful is displayed at the 
bottom of the screen.

Field Name Description

Total A + B ($) A system generated value displaying the total cost of 
repairs made in sections A and B.

Non Inspection Related 
Costs ($)

Enter the dollar amount for any costs that were 
incurred but are not directly related to the safety 
inspection.

Enter any comments related to this cost.

Repair Costs Not Entered 
Above ($)

Enter any additional repair costs that incurred during 
the inspection process, but are not directly addressed 
in the previous sections.

Inspection Cost ($) Enter the total cost for the inspection. Do not include 
tax or the value of the sticker.

Sticker Cost ($) Enter the cost of the sticker. Do not include inspection 
cost or tax.

Tax Rate Select the tax rate from the drop-down list.

To add no sales tax, leave this field blank, or select 
0.0. 

To manually add a tax amount, enter the amount in the 
Total Tax ($) field. This will automatically “select” the 
blank entry in the Tax Rate list.

Total Tax ($) If no tax rate was selected, or the tax amount needs to 
be changed, enter the amount here.

Grand Total ($) The total amount is generated by the application 
(including inspection cost, sticker cost and tax).
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Using the Barcode Scanner
A standard 2D barcode scanner can be used to scan a customer’s PennDOT 
registration card. Scanning the card will capture the owner and vehicle 
information that is provided on the registration card.

The following fields will be populated by scanning the registration barcode:

• Last Name / Company Name - registered owner

• First Name - registered owner

WARNING: The 
scanner takes the 
information 
directly from the 
barcode. The 
safety inspector 
must verify that 
this information is 
valid.

• City - registered owner

• County - registered owner

• VIN No - vehicle identification number

• Plate No (vehicle license plate)

• Model Year

• Make (vehicle make)

You do not need to retype the VIN when using the barcode scanner.

To Use the Barcode Scanner to Enter Information
1. Start a new safety inspection. See “Entering Safety Data” on page 34 for 

more information on how to do this.

NOTE: Fields that 
have an under-
lined description 
are fields that will 
populate when 
scanning a bar-
code.

2. Click Scan Registration Barcode.

The Scan Barcode screen is displayed, as shown in Figure 17.

Figure 17:  Scan Barcode Screen

3. Scan the barcode from the customer’s registration card.

The Scan Barcode shows the progress bar, as shown in Figure 17. When 
finished, the Scan Barcode screen closes. The customer and vehicle 
information is populated in the associated fields.

Or

Click Close on the Scan Barcode screen to cancel the scan process.

4. The application returns to the Safety Inspection screen.
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Completing/Finalizing Entered Safety Data
A safety inspection can be started when the customer brings their vehicle into 
the shop. The inspection can be completed at a later time. See “Safety Inspection 
Information” on page 37 for more information about which fields are required to 
save an inspection before completing all the information.

To Complete Entered Safety Data
1. Start a new safety inspection. See “To Enter Inspection, Owner and 

Vehicle Data” on page 38.

Or

Open a pending work order. See “To View Pending Work Orders” on 
page 51.

2. Enter the remaining safety inspection information.

3. Click Final.

The application verifies that all required information has been entered. A 
message is displayed at the top of the screen if any errors were found. 
Click on the message to display a list of fields than need to be fixed.

Click Final when all fields have been corrected.

A message indicating that the save was successful is displayed at the 
bottom of the page. The message also includes the system-assigned 
record number.

Canceling a Safety Inspection
A safety inspection can be cancelled prior to saving. Cancelling the inspection 
prior saving as pending or saving as final will remove the record from the 
system. This procedure only works for inspections that are not finalized or saved 
as pending. Clicking Cancel on a pending work order will exit the inspection 
without saving any changes. The work order is returned to the pending screen. If 
the work order is set to final, it cannot be canceled or removed.

NOTE: After a 
safety inspection 
has been saved 
as pending it can 
be removed from 
the system. See 
“To Remove 
Pending Work 
Orders” on 
page 55 for more 
information. 

To Cancel a Safety Inspection
1. Click Cancel in the new safety inspection. See “Entering Safety Data” on 

page 34 for more information on starting an inspection.

2. A message is displayed informing you that any changes entered will not 
be saved. Click OK.

The application returns to the main screen.
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Working With Pending Work Orders
A safety inspection can be started when the customer takes their vehicle into the 
shop. The inspection can be completed at a later time. The safety inspector or 
other station personnel can then open a pending work order, complete the 
remaining safety information and mark the inspection as completed.

To View Pending Work Orders
1. Click Pending W.O. in the main menu. The Pending Work Orders screen 

is displayed, as shown in Figure 18.

Figure 18:  Pending Work Orders Screen

2. Locate the appropriate safety test by scrolling through the list of pending 
work orders.

3. Click the link for the work order in the System Record No column. The 
Safety Inspection screen is displayed, as shown in Figure 19.
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Figure 19:  Safety Inspection Screen

4. Enter any incomplete information.

NOTE: Once you 
click Keep Pend-
ing, the safety 
inspection can 
only be accessed 
from the Pending 
Work Orders 
screen. See “To 
View Pending 
Work Orders” on 
page 51 for more 
information.

5. Scroll to the bottom of the page and click Keep Pending to save the 
entered information. See “To Finalize Pending Work Orders” on page 53 
for information on finalizing work orders.
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To Finalize Pending Work Orders
1. Click Pending W.O. in the main menu. The Pending Work Orders screen 

is displayed, as shown in Figure 18.

Figure 20:  Pending Work Orders Screen

2. Locate the appropriate safety test by scrolling through the list of pending 
work orders.

3. Click the link for the work order in the System Record No column. The 
Safety Inspection screen is displayed, as shown in Figure 21.
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Figure 21:  Safety Inspection Screen Showing Inspection Details

4. Enter any incomplete information.

5. Scroll to the bottom of the page and click Final to save the entered 
information and mark the inspection as complete.

A message indicating that the save was successful is displayed at the 
bottom of the page.
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To Remove Pending Work Orders
If a safety inspection is started, but then is determined to be invalid for any 
reason, it can be removed from the system. This can only be done if the work 
order is pending. If the work order is set to final, it cannot be removed.

NOTE: A safety 
inspection can be 
cancelled prior to 
be saved as 
pending or final. 
See “To Cancel a 
Safety Inspec-
tion” on page 50 
for more informa-
tion. 

1. Click Pending W.O. in the main menu. The Pending Work Orders screen 
is displayed, as shown in Figure 22.

Figure 22:  Pending Work Orders Screen

2. Locate the appropriate safety test by scrolling through the list of pending 
work orders.

3. Select one or more check box in the Remove column next to the 
appropriate work order(s).

4. Click REMOVE. The application prompts: Are you are sure you want to 
continue?.

5. Click OK.

6. The screen refreshes with the pending work order(s) removed from the 
list.
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5. Maintaining Sticker Inventory
The e-SAFETY Application provides the ability to maintain safety inspection 
stickers. Sticker maintenance includes correction sticker numbers that were 
entered incorrectly, voiding damaged, stolen or missing stickers and issuing 
replacement stickers.

The following sections are contained within this chapter:

• “Entering Corrected Safety Stickers”  . . . . . . . . . . . . . . . . . . . . . .  page 58

• “Entering Void-Damaged, Stolen and Missing Safety Stickers”  .  page 60

• “Entering Replacement Safety Stickers” . . . . . . . . . . . . . . . . . . . .  page 62
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Entering Corrected Safety Stickers
Sticker numbers must be corrected through the e-SAFETY Application when 
they are incorrectly entered during a safety inspection. Recording of these 
stickers is done through the Correction Safety Sticker screen.

To Enter Corrected Safety Sticker Information
1. Select Safety Stickers > Sticker Corrections in the main menu. The 

Correction Safety Sticker screen is displayed, as shown in Figure 23.

Figure 23:  Correction Safety Sticker Screen

NOTE: If you do 
not know the sys-
tem record num-
ber, you can run 
a Station Inspec-
tion History 
Report. See “Sta-
tion Safety 
Inspection His-
tory Report” on 
page 94 for more 
information.

The following table provides details about each field:

2. Click Save.

Field Name Description

System Record No Enter the system record number associated with the 
incorrect sticker number.

Previous Sticker No Enter the sticker number that was incorrectly entered.

Correct Sticker No Enter the 10 character alphanumeric sticker number in 
a XX99999999 format where XX is AI, AO or SI (no 
other sticker prefix is valid).

Expiration (MM-YYYY) Enter the month and year that the safety sticker will 
expire. The month should be designated with a two 
character entry. For example, July = 07. The year 
entry should be entered in a yyyy format.

The expiration date must not be less than six months 
and no more than 15 months after the current 
calendar year.
- 58 -
Application Solutions

July 9, 2008 1:33 pm TDG



Entering Corrected Safety Stickers

Pennsylvania e-SAFETY Program
e-SAFETY Application User Manual

Doc Ver 5.00 / App Ver 3.07.01
The application validates the information entered and prompts you to 
correct any invalid entries.

A message is displayed at the bottom of the screen informing you that the 
sticker was updated and saved correctly.
- 59 -
Application Solutions

July 9, 2008 1:33 pm TDG



Entering Void-Damaged, Stolen and Missing Safety Stickers

Pennsylvania e-SAFETY Program
e-SAFETY Application User Manual

Doc Ver 5.00 / App Ver 3.07.01
Entering Void-Damaged, Stolen and Missing 
Safety Stickers
Sticker numbers must be entered into the e-SAFETY Application when they are: 
voided from damage, stolen or cannot be accounted for because they are missing. 
This process is for stickers that have yet to be assigned to a vehicle. Recording of 
these stickers is done through the Void-Damaged/Stolen/Missing Sticker screen.

To Enter Void-Damaged, Stolen, Missing Safety Sticker Information
1. Select Safety Stickers > Void-Damaged/Stolen/Missing Stickers from 

the main menu. The Void-Damaged/Stolen/Missing Sticker screen is 
displayed, as shown in Figure 24.

The screen dynamically changes depending whether the Void/Damage or 
Stolen selection fields are chosen. When Stolen is selected, the Date of 
Reporting to Authorities and Reported To fields become enabled. By 
default, the screen displays with Void/Damage selected, as shown in 
Figure 24.

Figure 24:  Void-Damaged/Stolen/Missing Safety Sticker Screen

2. Enter the sticker information.

WARNING: The 
sticker number 
prefix cannot be 
an “IM” designa-
tion. This is for 
emissions stick-
ers only.

The following table provides details about each field:

Field Name Description

Single Sticker / Multiple 
Stickers

Select the appropriate option. The screen will change 
depending on the choice.
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3. Click Save.

NOTE: When 
entering a range 
of stickers, the 
start date must 
be before the end 
date. Also, the 
range cannot 
exceed 100 stick-
ers.

The application validates the information entered and prompts you to 
correct any invalid entries.

A message is displayed at the bottom of the screen informing you that the 
information was updated and saved correctly.

Start Sticker No Enter the 10 character alphanumeric sticker number in 
a XX99999999 format where XX is AI, AO or SI (no 
other sticker prefix is valid). Enter the sticker number 
if the Single Sticker No. option is selected. If 
Multiple Sticker No. option is selected, enter the 
beginning number in a complete set of sticker 
numbers.

End Sticker No If entering a sticker range, enter the ending 10 
character alphanumeric sticker number in a 
XX99999999 format where XX is AI, AO or SI (no 
other sticker prefix is valid). The range from Start 
Sticker No. and End Sticker No. cannot be larger 
than 100. 

Void / Damage, Stolen or 
Missing

Select Void / Damage, Stolen or Missing.

When selecting Stolen as the sticker status, the 
screen dynamically changes to include the Date of 
Reporting to Authorities and the Reported To fields.

Stolen / Missing Reported 
To

Select who the stolen sticker(s) were reported to. The 
choices are: PennDOT, Auditor and State or Local 
Police.

This field is only displayed when the reason for 
entering this ticket is Stolen or Missing.

Field Name Description
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Entering Replacement Safety Stickers
A customer can receive a replacement sticker if for some reason the sticker 
affixed to their vehicle becomes damaged. The customer will need to bring in 
proof of the damaged sticker in order to receive a replacement.

Safety sticker replacements can be made for all vehicle types. The screens for 
these three replacement types are primarily the same. Fields not used for 
motorcycles and trailers will not be editable.

NOTE: Some 
data is not col-
lected for certain 
vehicle types. In 
MS Internet 
Explorer, the field 
will be unedit-
able. In Firefox, 
the field is 
shaded as well as 
being un-edit-
able.

The following table lists the vehicle types.

For purpose of this example, the passenger vehicle inspection will be used.

Form Used When

MV-431 Vehicle Type:

• Passenger Car

• Light Truck

• Medium Truck

• Heavy Truck

• Bus

• School Bus

• Motor Home

MV-480 Vehicle Type:

• Motorcycle/Motor-Driven Cycle

• Moped/Motorized Pedal-Cycle

• Trailer

• Reconstructed/Specially Constructed
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To Enter Replacement Safety Sticker Information
1. Select Safety Stickers > Replacement Stickers > MV431 or MV-480 

from the main application menu and select the vehicle type. The 
Replacement Safety Stickers screen is displayed, as shown in Figure 25.

Figure 25:  Replacement Safety Stickers Screen

2. The following fields are auto-populated by the application:

3. Enter the preliminary safety inspection information.

Field Name Description

Vehicle Category System-provided field defining the vehicle type. For 
example: passenger vehicle, motorcycle or trailer. 
This field cannot be edited.

System Record No System-provided number. This number will be 
populated when the inspection is marked as Final or 
as Keep Pending. This field cannot be edited.
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NOTE: A bar-
code scanner can 
be used to auto-
matically fill in 
some of the per-
sonal and vehi-
cle information. 
See “Using the 
Barcode Scan-
ner” on page 49 
for more informa-
tion.

The following table provides details about each field:

4. Enter the vehicle registrant (owner) information.

The following table provides details about each field:

5. Enter the vehicle insurance information.

Field Name Description

Annual / Semi Annual Select whether the test type is an annual or semi 
annual safety inspection.

Work Order Enter the 10 digit alphanumeric work order number 
from the form. This is a required field when saving an 
inspection as pending.

Inspector Lic ID Enter the ID number for the person who performed the 
safety inspection. This is a required field when saving 
an inspection as pending.

Inspection Date Enter the date that the inspection took place in a mm/
dd/yyyy format. You can also click on the calendar 
icon to select the date. This is a required field when 
saving an inspection as pending.

Field Name Description

Last Name / Company 
Name

Enter the last name of the registered owner of the 
vehicle. This field can be filled in automatically by 
using a barcode scanner. This is a required field when 
saving an inspection as pending.

First Name Enter the first name of the registered owner of the 
vehicle. This field can be filled in automatically by 
using a barcode scanner. See “Using the Barcode 
Scanner” on page 49 for more information.

City Enter the city where the vehicle is registered. This 
field can be filled in automatically by using a barcode 
scanner. See “Using the Barcode Scanner” on 
page 49 for more information.

State Enter the alpha character designation for the 
registered vehicle owner.

ZIP Code Enter the five-digit ZIP Code for the registered vehicle 
owner.

County Enter the county where the vehicle is registered. This 
field can be filled in automatically by using a barcode 
scanner. See “Using the Barcode Scanner” on 
page 49 for more information.
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The following table provides details about each field:

6. Enter the vehicle identification information.

The following table provides details about each field:

Field Name Description

Company Enter the name of the insurance company for which 
the owner has a valid policy. Optionally, click the icon 
to the right of this field to select from a list of many of 
the available insurance companies.

NAIC No The five digit National Association of Insurance 
Commissioners (NAIC) number associated to the 
registered vehicle owner's insurance company.

Policy No Enter the alphanumeric insurance policy ID assigned 
to the registered vehicle owner by their insurance 
company.

Expires (mm/dd/yyyy) Enter the expiration date of the insurance policy for 
this vehicle. This date is entered in a mm/dd/yyyy 
format.

Field Name Description

VIN No Enter the vehicle identification number (VIN) for this 
vehicle. This number consists of 17 alphanumeric 
characters (21 for previously salvaged vehicles). This 
field can be filled in automatically by using a barcode 
scanner. This is a required field when saving an 
inspection as pending.

Retype VIN Re-type the VIN for this vehicle. This field is not 
required if the vehicle information was captured with 
the barcode scanner. See “Using the Barcode 
Scanner” on page 49 for more information.

Plate No Enter the registered license plate number for the 
vehicle. This field can be filled in automatically by 
using a barcode scanner. This is a required field when 
saving an inspection as pending. See “Using the 
Barcode Scanner” on page 49 for more information.

Old Odometer Enter the odometer reading that was captured during 
the previous safety inspection. This field is not 
available for trailers, motorcycles or motor driven 
cycles.

Click the icon to the right of this field for a drop-down 
list of available alternate entries (Out of State, No 
Previous Sticker, Unreadable and N/A).
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7. Enter the sticker information in the Safety Sticker section of the screen, 
as shown in Figure 26. 

Figure 26:  Enter Safety Data Screen Showing Safety Sticker Section

WARNING: The 
previous or new 
Sticker No prefix 
cannot be an “IM” 
designation. This 
is for emissions 
stickers only.

The following table provides details about each field:

Current Odometer Enter the current odometer reading at the time the 
safety inspection occurred. This field is not available 
for trailers.

Click the icon to the right of this field for a drop-down 
list of available alternate entry of Exempt.

Model Year Enter the numeric model year for the registered 
vehicle. This number is entered in a yyyy format. This 
field can be filled in automatically by using a barcode 
scanner. See “Using the Barcode Scanner” on 
page 49 for more information.

Make Enter the auto manufacturer information. This field 
can be filled in automatically by using a barcode 
scanner. See “Using the Barcode Scanner” on 
page 49 for more information.

Body Select the vehicle body style from the drop-down list.

Color Enter the primary color of the vehicle.

Field Name Description

Field Name Description

Comment Enter the reason for replacing the old sticker.

Previous Sticker No Enter the number of the previous sticker.

New Sticker No Enter the 10 character alphanumeric sticker number in 
a XX99999999 format where XX is AI, AO or SI (no 
other sticker prefix is valid).
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8. Enter the cost information in the Safety Sticker section of the screen.

The following table provides details about each field:

9. Click Keep Pending to save the entered information. See “Working With 
Pending Work Orders” on page 51 for more information.

Or

Click Final to save the entered information and mark the replacement as 
complete.

A message indicating that the save was successful is displayed at the 
bottom of the page.

Expiration (MM/YYYY) Enter the month and year that the safety sticker will 
expire. The month should be designated with a two 
character entry. For example, July = 07. The year 
entry should be entered in a YYYY format.

The expiration date must not be less than six months 
and no more than 15 months after the current 
calendar year.

Field Name Description

Replacement Labor Cost ($) Enter the cost of labor to replace the sticker.

Sticker Cost ($) The cost of the inspection replacement sticker.

Grand Total ($) The total amount is generated by the application 
(including replacement labor cost and replacement 
sticker cost).

Field Name Description
- 67 -
Application Solutions

July 9, 2008 1:33 pm TDG



Entering Replacement Safety Stickers

Pennsylvania e-SAFETY Program
e-SAFETY Application User Manual

Doc Ver 5.00 / App Ver 3.07.01
- 68 -
Application Solutions

July 9, 2008 1:33 pm TDG



Pennsylvania e-SAFETY Program
e-SAFETY Application User Manual

Doc Ver 5.00 / App Ver 3.07.01
6. Navigating PennDOT Bulletins
Periodically, the Pennsylvania Department of Transportation (PennDOT) will 
post safety inspection bulletins to their web site. The e-SAFETY Application 
provides a direct link to the Safety Inspection Bulletins web site.

The following sections is contained within this chapter:

• “Navigating to PennDOT Bulletins”  . . . . . . . . . . . . . . . . . . . . . . .  page 70
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Navigating to PennDOT Bulletins
PennDOT maintains a web site with archived safety bulletins. The e-SAFETY 
Application provides a direct link to this site.

To Navigate to PennDOT Bulletins
1. Click Safety Bulletins in the top left corner of the main menu bar.

A new browser window is opened, which displays the PennDOT Safety 
Inspection Bulletins web site, as shown in Figure 27.

Figure 27:  PennDOT Safety Inspection Bulletins Web Site

2. Close the browser window once you are done viewing the safety bulletins 
to return to the e-SAFETY Application.
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7. Report Basics
Using the instructions in the following sections, you will learn how to generate a 
sample report in the e-SAFETY Application. These sections also provide 
information about how to enter search criteria, generate reports, print reports 
and export or save report data.

For detailed information for each report available in the e-SAFETY Application, 
see “Report Descriptions” on page 83.

The following sections are contained within this chapter:

• “Report Basics”  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 72

• “Report Search Criteria” . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 72

• “About Generated Reports” . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 73

• “Generating a Sample Report”  . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 75

• “Exporting and Saving Reports” . . . . . . . . . . . . . . . . . . . . . . . . . .  page 77

• “Printing Reports” . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 81
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Report Basics
Because the process used to generate each of the different reports is the same, 
this section presents the steps for generating a sample Station Inspection 
History report. Detailed information about each individual report is provided in 
the section “Report Descriptions” on page 83.

Using the instructions in the following sections, you will learn how to generate a 
sample report. The following sections also provide information about how to 
enter search criteria, generate reports, print reports, save reports as a Portable 
Document Format (PDF), Excel or Rich Text Format (RTF) document.

Report Search Criteria
When running a report, the first screen that is displayed is a search criteria 
screen. Criteria such as date range, license ID and inspection results are 
examples of this data. The search criteria section, as shown in Figure 28, of each 
report contains search filters where you enter the information that will be used 
to locate the records that will be included in each report. The generated report 
will only include records that match the search criteria that you entered.

Figure 28:  Sample Search Criteria Screen
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About Generated Reports
Once a report has been generated, it displays similar to Figure 29.

NOTE: For 
instructions on 
generating a 
report, see the 
section “Generat-
ing a Sample 
Report” on 
page 75.

The body of the report displays results that match the report search criteria you 
entered.

Figure 29:  Sample Generated Report

A series of options for displaying, saving and printing reports appears at the top 
of the generated report. The following table provides a description of these 
options.

Option Description

TOC If a report has multiple sections or contains multiple records, a table of 
contents (TOC) can be displayed. This is a list of links that takes you to the 
first page of each section or record. Click a link to select and display the 
section or record.

First If a report has multiple pages, this is used to display the first page of the 
report.

Prev If a report has multiple pages, this is used to display the previous page of 
the report.
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Next If a report has multiple pages, this is used to display the next page of the 
report.

Last If a report has multiple pages, this is used to display the last page of the 
report.

Goto, Page If a report has multiple pages, this is used to display a specific page of the 
report. To do this, enter a page number in the Page field and click Go to.

Used to change the size of the report displayed on the screen. Select a 
percentage from the drop-down list. This does not change the size of the 
printed report.

Search This function is not currently being used.

Download Used to export and save a report as a portable document file (PDF), Excel 
file or rich text format file (RTF). For instructions, see the section “Exporting 
and Saving Reports” on page 77.

Print Used to print a hard copy of a report. For instructions, see the section 
“Printing Reports” on page 81.

Help Used to display information and instructions for exporting, saving and 
printing reports.

Used to close the window containing the generated report.

Option Description
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Generating a Sample Report
This section describes how to generate a sample report. Using these instructions, 
you will learn how to enter the Search Criteria to generate any of the reports 
accessed by this application.

The following instructions are identical for all reports generated using the e-
SAFETY Application. Because of this, the instructions describe a sample report 
to illustrate the process. However, the search criteria and generated report are 
different, depending on which report you select. For detailed information about 
the search criteria, see the section “Report Search Criteria” on page 72.

To Generate a Sample Report
1. Select the report to be generated from the Reports menu. The search 

criteria section for the report appears, similar to Figure 30.

Figure 30:  Sample Search Criteria Section

2. Enter information about the records you want to include in the report in 
the fields in the Search Criteria section. For additional information, see 
“Report Search Criteria” on page 72.

3. Click View Report after the Search Criteria has been entered.

Your default internet browser opens and displays the report, similar to 
Figure 31.
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Figure 31:  Sample Generated Report

4. Optionally, click Download to export and save the report as a PDF or 
Excel file. For more information, see “Exporting and Saving Reports” on 
page 77.

5. Optionally, click Print to print the report. For additional information, see 
the section “Printing Reports” on page 81.

6. Click  to exit the report and return to the Search Criteria section.
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Exporting and Saving Reports
Using these instructions, you will be able view, export and save a report in an 
external format, such as a PDF or Excel file. The instructions are identical for all 
reports generated using this application. The Station Safety Inspection History 
Detail Export will be used as an example.

To Export and Save Reports
1. Generate the report to be exported and saved. For instructions on how to 

generate a report, see “Generating a Sample Report” on page 75.

The selected report appears, as shown in Figure 32.

Figure 32:  Station Safety Inspection History - Detail Export

2. Click Download. The Download screen appears, as shown in Figure 33.
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Figure 33:  Download Screen

NOTE: If you 
select to export in 
PDF format, set 
the PDF options 
as needed..

3. In the Export Report To section, select the format in which the report 
will be saved by selecting the desired option. In this example, select the 
Excel Data opiton.

4. In the Page Range section, select whether to export all pages, the current 
page or a ranges of pages by selecting the appropriate option. If you 
select to print a range of pages, enter the page range in the field 
provided.

5. (Optional) Preview the report by clicking View Report. The report 
appears in a new window in the format selected in the Export Report To 
section.

6. Click Save Report to save the report in the format selected in the Export 
Report To section. The File Download window appears, as shown in 
Figure 34
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Figure 34:  File Download Window

7. Click Save. The Save As window appears, as shown in Figure 35.

Figure 35:  Save As Window

8. Locate the folder in which the file will be saved.

9. Enter a name for the file in the File name field, or you can accept the 
default name.

10. Click Save. The Download complete window appears, as shown in Figure 
36.
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Figure 36:  Download Complete Window

11. Click Open to open the file.

Or

Click Open Folder to open the folder in which the file is saved.

Or

Click Close to exit the screen without opening the file or the folder in 
which it is saved and return to the report screen.
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Printing Reports
This section describes how to print a report. Printing reports is useful for 
keeping a hard copy of a report on file. The instructions are identical for all 
reports generated using this application. Because of this, instructions use a 
sample report to illustrate the process. The station can provide this report to the 
station’s customers.

To Print a Report
1. Generate the report to be printed. For instructions on how to generate a 

report, see “Generating a Sample Report” on page 75.

The selected report appears, similar to Figure 37.

Figure 37:  Sample Generated Report

2. Click Print to print the report.

The application converts the report to a portable document file (PDF) file 
and the Print window appears.

3. In the Print window, make any necessary changes to the settings and click 
Print to print the report.
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8. Report Descriptions
The e-SAFETY Application generates reports that are used for managing safety 
data and analyzing the effectiveness of the program.

The following sections provide detailed information about each report that can 
be generated using this application. The information includes an illustration of 
each generated report.

The following sections are contained within this chapter:

• “Report Descriptions”  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 84

• “Inspection Report” . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 84

• “Replacement Sticker Report”  . . . . . . . . . . . . . . . . . . . . . . . .  page 89

• “Vehicle Safety Inspection History Report” . . . . . . . . . . . . . .  page 92

• “Station Safety Inspection History Report”  . . . . . . . . . . . . . .  page 94

• “Station Safety Inspection History Detailed Export” . . . . . . .  page 96

• “Sticker Usage Report”  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 101
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Report Descriptions
The reports are used for managing safety data and analyzing the effectiveness of 
the program. For instructions on generating, printing, exporting and saving the 
report, see the sections “Report Basics” on page 72.

Inspection Report
The Safety Inspection report provides the details of a safety inspection. This 
report is used to review the results of a single inspection. The station can provide 
this report to the station’s customers

To access the report, select Reports >Safety Inspection.

For instructions on generating the report, see the section “Generating a Sample 
Report” page 75. For instructions on printing, exporting and saving the report, 
see the sections “Printing Reports” page 81 and “Exporting and Saving Reports” 
page 77.

Figure 38 provides an example of a generated Safety Inspection report.
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Figure 38:  Safety Inspection Report
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The following table provides a description for each of the fields found in this 
report:

Field Description

ID The unique identification number assigned to the station 
where the inspection was performed.

Name The station name associated with the station ID.

System Record # System provided number. This number is populated when the 
inspection is marked as Final or as Keep Pending.

Work Order # The ten digit alphanumeric work order number from the 
inspection form.

Address The station’s location address including: street address, city, 
state and ZIP Code.

Name The customer’s first and last name. This can also be a 
company name if the vehicle is owned by the company.

City The city where the vehicle is registered.

County The county where the vehicle is registered.

State The state where the vehicle is registered.

Zip The ZIP code where the vehicle is registered.

Inspection Date The date that the inspection took place in a mm/dd/yyyy 
format.

Overall Results Indicates whether the vehicle passed or failed the safety 
inspection.

Inspection Type Inspection Type (Annual or Semi-annual)

Inspector Name The of the person who performed the safety inspection.

Sticker # The 10 character alphanumeric sticker number in a 
XX99999999 format where XX is AI, AO or SI (no other sticker 
prefix is valid). “Fail” is displayed if the vehicle did not pass the 
safety inspection.

Sticker Expiration The month and year that the safety sticker expires.

The expiration date must not be less than six months and no 
more than 15 months after the current calendar year.

VIN The vehicle identification number (VIN) for this vehicle. This 
number consists of 17 alphanumeric characters (21 for 
previously salvaged vehicles).

Year The numeric model year for the registered vehicle. This 
number is displayed in a yyyy format.

Make The auto manufacturer information.

Body The body style for the vehicle. The choices for passenger 
vehicles include: sedan, station wagon, pickup, SUV, minivan 
and full size van. This field is not applicable for motorcycle. 
The choices for trailer include: trailer and semi.

Color The color of the vehicle.

Type The conveyance type for the vehicle.
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Plate The license plate number that is recorded for the vehicle.

County Registered The county that has been registered for the vehicle.

Old Odometer The odometer reading that was captured during the previous 
safety inspection.

Current Odometer The current odometer reading at the time the safety inspection 
occurred.

City Registered The city that has been registered for the vehicle.

Lowest Tire Reading Displays information about the tire inspection including:

• Tread reading

• Side that the tire is located

• Axle location

• Wheel location

Front Brake Reading Displays information about the front brake inspection 
including:

• Brake thickness

• Side the brake is located

• Brake type

Rear Brake Reading Displays information about the front brake inspection 
including:

• Brake thickness

• Side the brake is located

• Brake type

Tires & Wheels Displays Pass or Fail, repair cost and any associated 
comments.

Steering & Suspension Displays Pass or Fail, repair cost and any associated 
comments.

Exhaust System Displays Pass or Fail, repair cost and any associated 
comments.

Fuel System Displays Pass or Fail, repair cost and any associated 
comments.

Glazing & Mirrors Displays Pass or Fail, repair cost and any associated 
comments.

Lights, Wiring & Switches Displays Pass or Fail, repair cost and any associated 
comments.

Body, Doors, & Latches Displays Pass or Fail, repair cost and any associated 
comments.

Brake System Displays Pass or Fail, repair cost and any associated 
comments.

Other Displays Pass or Fail, repair cost and any associated 
comments.

Field Description
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Road Test A Pass or Fail designation for the vehicle road test and any 
associated comments. This field is blank for reconstructed and 
specially constructed vehicles.

Registration/Ownership 
Verified

A yes or no value for if the vehicle registration was verified. 
This field is blank for reconstructed and specially constructed 
vehicles.

Catalytic Converter Displays Pass, New, Fail, Adjust, Repair or N/A for the safety 
inspection results. Also shows cost of repair and any 
associated comments.

Fuel Inlet Restrictor Displays Pass, New, Fail, Adjust, Repair or N/A for the safety 
inspection results. Also shows cost of repair and any 
associated comments.

PCV Valve Displays Pass, New, Fail, Adjust, Repair or N/A for the safety 
inspection results. Also shows cost of repair and any 
associated comments.

EGR Valve Displays Pass, New, Fail, Adjust, Repair or N/A for the safety 
inspection results. Also shows cost of repair and any 
associated comments.

Air Pump Displays Pass, New, Fail, Adjust, Repair or N/A for the safety 
inspection results. Also shows cost of repair and any 
associated comments.

Evaporative Control System Displays Pass, New, Fail, Adjust, Repair or N/A for the safety 
inspection results. Also shows cost of repair and any 
associated comments.

Cost Sum of additional costs for repairs or adjustments.

Repair Costs Not Entered 
Above

Displays any additional cost incurred during the inspection that 
were required to pass.

Inspection Cost The total amount charged for the inspection (not including 
repairs and adjustments.

Sticker Cost The fee charged for the inspection sticker.

Non-Inspection Related 
Cost

Displays any non-inspection related cost incurred during the 
inspection.

Total Tax Any taxes incurred for the inspection and/or repair.

Grand Total The total of all fees and costs for the safety inspection and 
resulting sticker.

Inspector’s Signature This provides and area for the inspector to sign the final 
inspection report.

Field Description
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Replacement Sticker Report
The Safety Sticker Replacement report provides details about a single 
replacement sticker transaction. The station can provide this report to the 
station’s customers.

A customer can receive a replacement sticker if for some reason the sticker 
affixed to their vehicle becomes damaged. The customer will need to bring in 
proof of the damaged sticker in order to receive a replacement.

To access the report, select Reports > Sticker Replacement.

For instructions on generating the report, see the section “Generating a Sample 
Report” page 75. For instructions on printing, exporting and saving the report, 
see the sections “Printing Reports” page 81 and “Exporting and Saving Reports” 
page 77.

Figure 39 provides an example of a generated Safety Sticker Replacement 
report.

Figure 39:  Safety Sticker Replacement Report
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The following table provides a description for each of the fields found in this 
report:

Field Description

ID The unique identification number assigned to the station 
where the inspection was performed.

Name The station name associated with the station ID.

System Record # System provided number. This number is populated when the 
inspection is marked as Final or as Keep Pending.

Work Order # The ten digit alphanumeric work order number from the form.

Address The station’s location address including; street address, city, 
state, ZIP Code.

Name The customer’s first and last name. This can also be a 
company name if the vehicle is owned by the company.

City The city where the vehicle is registered.

County The county where the vehicle is registered.

State The state where the vehicle is registered.

Zip The ZIP code where the vehicle is registered.

Inspection Date The date the vehicle was inspected.

Inspector Name The of the person who performed the safety inspection.

Inspection Type Inspection Type (Annual or Semi-annual)

Old Sticker The previous sticker number assigned to this inspection.

Sticker # The 10 character alphanumeric sticker number in a 
XX99999999 format where XX is AI, AO or SI (no other sticker 
prefix is valid). If the safety inspection resulted in a fail to 
pass, FAIL is displayed.

Sticker Expiration The month and year that the safety sticker expires.

The expiration date must not be less than six months and no 
more than 15 months after the current calendar year.

VIN The vehicle identification number (VIN) for this vehicle. This 
number consists of 17 alphanumeric characters (21 for 
previously salvaged vehicles).

Year The numeric model year for the registered vehicle. This 
number is displayed in a yyyy format.

Make The auto manufacturer information.

Body The body style for the vehicle. The choices for passenger 
vehicles include: sedan, station wagon, pickup, SUV, minivan 
and full size van. This field is not applicable for motorcycle. 
The choices for trailer include: trailer and semi.

Color The color of the vehicle.

Type The conveyance type for the vehicle.

Plate The license plate number that is recorded for the vehicle.

County The county that has been registered for the vehicle.
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Old Odometer The odometer reading that was captured during the previous 
safety inspection.

Current Odometer The current odometer reading at the time the safety inspection 
occurred.

City Registered The city that has been registered for the vehicle.

Replacement Comment The comment reason for replacing the sticker.

Replacement Labor Cost The total amount charged for labor to replace the inspection 
sticker.

Sticker Cost The fee charged for the inspection sticker replacement.

Grand Total The total of all fees and costs for the safety inspection and 
resulting sticker.

Inspector’s Signature This provides and area for the inspector to sign the final 
inspection report.

Field Description
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Vehicle Safety Inspection History Report
The Vehicle Safety Inspection History report provides a summary view of each 
inspection performed on a specific vehicle. The station can provide this report to 
the station’s customers.

To access the report, select Reports > Vehicle History.

For instructions on generating the report, see the section “Generating a Sample 
Report” page 75. For instructions on printing, exporting and saving the report, 
see the sections “Printing Reports” page 81 and “Exporting and Saving Reports” 
page 77.

Figure 40 provides an example of a generated Vehicle Safety Inspection History 
report.

Figure 40:  Vehicle Safety Inspection History Report

The following table provides a description for each of the fields found in this 
report:

Field Description

AS OF The date the report was retrieved from the system. This date is 
displayed in a mm/dd/yyyy format.

VIN The vehicle identification number (VIN) for this vehicle. This 
number consists of 17 alphanumeric characters (21 for 
previously salvaged vehicles).

Year The numeric model year for the registered vehicle. This 
number is displayed in a yyyy format.

Make The auto manufacturer information.

Body The body style for the vehicle. 

Vehicle Type The conveyance type for the vehicle.

Inspection Date The date that the inspection was completed. This date is 
provided in a mm/dd/yyyy format.
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Sticker # The number of the safety sticker associated with the 
inspection. This number can be found pre-printed on the 
sticker.

Overall Results Indicates whether the vehicle passed or failed the safety 
inspection or has a replacement sticker.

Previous Odometer Reading The vehicle mileage recorded during the previous inspection.

Current Odometer Reading The vehicle mileage recorded during the inspection.

Number of Inspections The number of safety inspections and sticker replacements 
performed on that VIN.

Field Description
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Station Safety Inspection History Report
The Station Safety Inspection History report provides a summary of each 
inspection performed by a specific station during a chosen date range. This 
report is used by station personnel to review a station’s performance.

To access the report, select Reports > Station Inspection History > Summary.

For instructions on generating the report, see the section “Generating a Sample 
Report” page 75. For instructions on printing, exporting and saving the report, 
see the sections “Printing Reports” page 81 and “Exporting and Saving Reports” 
page 77.

Figure 41 provides an example of a generated Station Safety Inspection History 
report.

Figure 41:  Station Safety Inspection History Report
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The following table provides a description for each of the fields found in this 
report:

Field Description

From / To (date) The date range the report was retrieved from the system. 
These dates are displayed in a mm/dd/yyyy format.

Station ID The unique identification number assigned to the station 
where the inspection was performed.

Inspector The ID number for the person who performed the safety 
inspection. Displays All when every inspector assigned to that 
station is retrieved.

Overall Inspection Results Displays if the report was queried for inspections that resulted 
in a Pass, Fail or for All results.

Inspection Date The date that the inspection was completed. This date is 
provided in a mm/dd/yyyy format.

Sticker # The number of the safety sticker associated with the 
inspection. This number can be found pre-printed on the 
sticker.

Work Order # The number on the station work order form used during the 
safety inspection process.

System Record # The unique system-generated identification number 
associated to the safety inspection.

Inspector ID The unique identification number for the inspector who 
performed the safety inspection.

VIN Vehicle Identification Numbers (VINs) are used to uniquely 
identify motor vehicles. This number consists of 17-21 
alphanumeric characters.

Plate The license plate number of the vehicle that received a safety 
inspection.

Year The year that the vehicle was manufactured.

Make The manufacturer’s make for the vehicle inspected.

Body The body style for the vehicle. 

Vehicle Type The type of vehicle inspected.

Overall Result Indicates whether the vehicle passed or failed the safety 
inspection or has a replacement sticker.

Entered By The user ID of the person who entered the safety inspection 
information.
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Station Safety Inspection History Detailed Export
The Station Safety Inspection History Detailed Export allows station managers 
to have a detailed view of each safety inspection performed at that station. 
Station managers can select to view information for each inspector. You can 
search by any date range and choose to view information for an individual 
inspector or all inspectors. You can choose to view information for all 
inspections, inspections with a passing result or inspections with a failed result.

To access the Station Safety Inspection History Detailed Export, select Reports 
> Station Inspection History > Detailed Export.

WARNING: It is 
recommended 
that instead of 
printing the Sta-
tion Inspection 
History Detailed 
Export, try 
exporting the 
data from the e-
SAFETY Applica-
tion and import 
the data into 
Microsoft Excel 
where it can be 
manipulated and 
printed. See 
“Exporting and 
Saving Reports” 
on page 77 for 
more information.

For instructions on generating the report, see the section “Generating a Sample 
Report” page 73. For instructions on exporting and saving the report, 
see“Exporting and Saving Reports” on page 77.

Figure 42 provides an example of the generated report.

Figure 42:  Station Safety Inspection History Detailed Export Report

The following table provides a description for each of the fields found in this 
report:

Field Description

System Record # System-provided reference number.

Work Order # The 10-digit alphanumeric work order number from the form.

Customer First Name The first name of the registered owner of the vehicle. 

Customer Last Name The last name of the registered owner of the vehicle.

Customer City The city where the vehicle is registered. 

State The state where the vehicle is registered.

Zip The zip code where the vehicle is registered

Customer County The county where the vehicle is registered
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Inspection Date The date the vehicle was inspected.

Inspection Type Inspections can be one of three types: Annual, Semi-Annual or 
One-Time Safety.

Inspector First and Last 
Name

The first and last name of the person who performed the 
inspection.

Overall Results Inspection can have an overall result of Pass or Fail or blank 
for a sticker replacement.

Sticker # The 10-character alphanumeric sticker number in a 
XX99999999 format where XX is AI, AO or SI.

Sticker Expiration The month and year that the safety sticker will expire. The 
month is given as a two character entry. For example, July = 
07. The year is given in a yyyy format.

Old Sticker # The number of the sticker that is being replaced.

Sticker Replacement Labor The cost of the labor to replace the sticker.

Sticker Replacement 
Comment

Comments regarding the sticker replacement.

VIN The vehicle identification number (VIN) for this vehicle. This 
number consists of 17 alphanumeric characters (21 for 
previously salvaged vehicles). The letters “TBI” indicate that a 
VIN is still “to be issued” for the vehicle.

Vehicle Plate The registered license plate number for the vehicle.

Vehicle County Registered The county where the vehicle is registered.

Vehicle Make The vehicle manufacturer.

Vehicle Model Year The numeric model year for the registered vehicle. This 
number is given in a yyyy format.

Vehicle Type The type of vehicle under inspection, as defined by the MV-
431 and MV-480 forms.

Vehicle Color The primary vehicle color.

Vehicle Body The vehicle body style.

Vehicle Insurance Company The name of the insurance company for which the owner has a 
valid policy.

Vehicle Insurance NAIC The five-digit National Association of Insurance 
Commissioners (NAIC) number associated with the registered 
vehicle owner's insurance company.

Vehicle Insurance Policy The alphanumeric insurance policy ID assigned with the 
registered vehicle owner by their insurance company. 

Vehicle Insurance 
Expiration

The expiration date of the insurance policy for this vehicle. 
The date is displayed in a mm/dd/yyyy format.

Vehicle Old Odometer The odometer reading that was captured during the previous 
safety inspection. 

Reconstructed and Specially Constructed Vehicles are given 
as: Recon, Specon or Modify.

Field Description
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Vehicle New Odometer The current odometer reading at the time the safety inspection 
occurred.

Lowest Tire Reading The value of the tire tread measurement with the lowest 
reading.

Lowest Tire Reading Side The side of the vehicle with the lowest tire reading: Left, Right 
or Middle.

Lowest Tire Reading Axle The location of the axle that gave the lowest tire reading: 
Front, Middle or Rear.

Lowest Tire Reading Wheel The location of the wheel that gave the lowest tire reading: 
Inner, Outer or Single.

Front Brake Reading The front brake measured thickness expressed in thirty- 
seconds of an inch.

Front Brake Reading Side The side of the vehicle where the brake measurement was 
taken: Left, Right or Middle.

Front Brake Type The break lining type: Riveted, Bonded or Bolted.

Rear Brake Reading The rear brake measured thickness expressed in thirty- 
seconds of an inch.

Rear Brake Reading Side The side of the vehicle where the brake measurement was 
taken: Left, Right or Middle.

Rear Brake Type The break lining type: Riveted, Bonded or Bolted.

Tire & Wheels Result The tire and wheel inspection result: Pass, New, Fail, Adjust, 
Repair or N/A.

Tire & Wheels Result Cost $ 
(w/o tax)

The cost to make repairs, not including tax.

Tire & Wheels Result 
Comment

Comments related to this inspection or repair.

Steering & Suspension 
Result

The steering and suspension inspection result: Pass, New, 
Fail, Adjust, Repair or N/A.

Steering & Suspension 
Result Cost $ (w/o tax)

The cost to make repairs, not including tax.

Steering & Suspension 
Result Comment

Comments related to this inspection or repair.

Exhaust System Result The exhaust system inspection result: Pass, New, Fail, Adjust, 
Repair and N/A.

Exhaust System Result 
Cost $ (w/o tax)

The cost to make repairs, not including tax.

Exhaust System Result 
Comment

Comments related to this inspection or repair.

Fuel System Result The fuel system inspection result: Pass, New, Fail, Adjust, 
Repair and N/A.

Fuel System Result Cost $ 
(w/o tax)

The cost to make repairs, not including tax.

Field Description
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Fuel System Result 
Comment

Comments related to this inspection or repair.

Glazing & Mirrors Result The glazing and mirror inspection result: Pass, New, Fail, 
Adjust, Repair or N/A.

Glazing & Mirrors Result 
Cost $ (w/o tax)

The cost to make repairs, not including tax.

Glazing & Mirrors Result 
Comment

Comments related to this inspection or repair.

Lights, Wiring & Switches The lights, wiring and switches inspection result: Pass, New, 
Fail, Adjust, Repair or N/A.

Lights, Wiring & Switches 
Result Cost $ (w/o tax)

The cost to make repairs, not including tax.

Lights, Wiring & Switches 
Result Comment

Comments related to this inspection or repair.

Body, Door & Latches 
Result

The body, door and latches inspection result: Pass, New, Fail, 
Adjust, Repair or N/A.

Body, Door & Latches 
Result Cost $ (w/o tax)

The cost to make repairs, not including tax.

Body, Door & Latches 
Result Comment

Comments related to this inspection or repair.

Brake System Result The brake system inspection result: Pass, New, Fail, Adjust, 
Repair or N/A.

Brake System Result Cost $ 
(w/o tax)

The cost to make repairs, not including tax.

Brake System Result 
Comment

Comments related to this inspection or repair.

Test Result Other The “other” inspection result: Pass, New, Fail, Adjust, Repair 
or N/A.

Test Result Other Cost $ (w/
o tax)

The cost to make repairs, not including tax.

Test Result Other Comment Comments related to this inspection or repair.

Road Test Result The road test result: Pass or Fail.

Road Test Result Comment Comments related to this road test.

Reg/Owner Verified Captures the verification of ownership for the vehicle under 
inspection: Yes or No.

Catalytic Converter Result The catalytic converter inspection result: Pass, New, Fail, 
Adjust, Repair or N/A.

Catalytic Converter Result 
Cost $ (w/o tax)

The cost to make repairs, not including tax.

Catalytic Converter Result 
Comment

Comments related to this inspection or repair.

Fuel Inlet Restrictor Result The fuel inlet restrictor inspection result: Pass, New, Fail, 
Adjust, Repair or N/A.

Field Description
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Fuel Inlet Restrictor Result 
Cost $ (w/o tax)

The cost to make repairs, not including tax.

Fuel Inlet Restrictor Result 
Comment

Comments related to this inspection or repair.

PCV Valve Result The PCV Valve inspection result: Pass, New, Fail, Adjust, 
Repair or N/A.

PCV Valve Result Cost $ (w/
o tax)

The cost to make repairs, not including tax.

PCV Valve Result 
Comments

Comments related to this inspection or repair.

EGR Valve Result The EGR Valve inspection result: Pass, New, Fail, Adjust, 
Repair or N/A.

EGR Valve Result Cost $ 
(w/o tax)

The cost to make repairs, not including tax.

EGR Valve Result Comment Comments related to this inspection or repair.

Air Pump Result The air pump inspection result: Pass, New, Fail, Adjust, Repair 
or N/A.

Air Pump Result Cost $ (w/o 
tax)

The cost to make repairs, not including tax.

Air Pump Result Comments Comments related to this inspection or repair.

Evaporative Control Sys 
Result

The evaporative control system inspection result: Pass, New, 
Fail, Adjust, Repair or N/A.

Evaporative Control Sys 
Result Cost $

The cost to make repairs, not including tax.

Evaporative Control Sys 
Result Comments

Comments related to this inspection or repair.

Summary Cost The sum of the cost of repairs done for group A items (non-
anti-tampering) and group B items (visual anti-tampering). 

Repair Costs Not Entered 
Above

Any additional repair costs incurred during the inspection 
process, but are not directly addressed in the previous 
sections.

Inspection Cost Thecost of the inspection, not including tax or the cost of the 
sticker.

Sticker Cost The cost of Safety Sticker, not including inspection cost or tax.

Non-Inspection Related 
Cost

The dollar amount for any costs incurred not directly related to 
the safety inspection.

Non-Inspection Related 
Cost Comment

Comments related to non-inspection related costs.

Total Tax The total of all sales tax for this inspection and related repairs.

Grand Total The total amount is generated by the application (including 
inspection cost, sticker cost and tax.)

Entered By The e-SAFETY Application user name of the person who 
entered the inspection data.

Field Description
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Sticker Usage Report
The Sticker Usage report provides a list of stickers issued during safety 
inspections by a station. The station owner uses this report to reconcile the 
number of stickers entered into the system with the number of actual stickers 
that have been used.

To access the report, select Reports > Sticker Usage.

For instructions on generating the report, see the section “Generating a Sample 
Report” page 75. For instructions on printing, exporting and saving the report, 
see the sections “Printing Reports” page 81 and “Exporting and Saving Reports” 
page 77.

Figure 43 provides an example of a generated Sticker Usage report.

Figure 43:  Sticker Usage Report
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The following table provides a description for each of the fields found in this 
report:

Field Description

Sticker Issued From / To 
(date)

The date range the report was retrieved from the system. 
These dates are displayed in a mm/dd/yyyy format.

Station ID The unique identification number assigned to the station 
where the inspection was performed.

Sticker # The number of the safety sticker associated with the 
inspection. This number can be found pre-printed on the 
sticker.

Work Order # The number on the station work order form used during the 
safety inspection process.

System Record # The unique system-generated identification number 
associated to the safety inspection.

Date Issued The date that the safety inspection sticker was issued.

Reason Identifies the reason that a sticker was issued or replaced.

VIN Vehicle identification numbers (VINs) are used to uniquely 
identify motor vehicles. This number consists of 17-21 
alphanumeric characters.

Plate The license plate number of the vehicle that received a safety 
inspection.
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9. Application Administration
The e-SAFETY Application provides an Administration menu that allows you to 
perform application administration tasks. For users with the role of Station 
Manager, station users can be added to the system or modified. All users can 
modify their own password through the administration menu.

The following sections are contained within this chapter:

• “Managing Station Users” . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 104

• “Changing User Passwords”  . . . . . . . . . . . . . . . . . . . . . . . . . . . .  page 108
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Managing Station Users
The Manage Station Users screen is used to create new users and inactivate 
existing users. Only users with the role of Station Manager can access this 
screen.

To Add a Station User
1. Select Administration > Manage Station Users from the main 

application menu. The Manage Station Users screen appears, as shown 
in Figure 44.

TIP: You must 
contact technical 
support to modify 
new users with 
the role of Station 
Manager.

Figure 44:  Manage Station Users Screen

2. Click Add New Users. The Add New User screen is displayed, as shown 
in Figure 45.
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Figure 45:  Add New User Screen

3. Enter the required user information. 

The following table provides details about each field:

4. Click Save. The application saves the new user information.

Or

Click Cancel to return to the Manage Station Users screen.

5. Select Administration > Manage Station Users from the main 
application menu. The Manage Station Users screen appears with the 
new user information listed on the screen.

Field Name Description

Last Name Type the user’s last name using all capital, alpha 
characters.

First Name Type the user’s first name using all capital, alpha 
characters.

User ID This field is system generated when the other fields 
are completed and you click Save. The user ID cannot 
be modified.

Password Type the user’s password using all capital, 
alphanumeric characters. Password can only be 10 
characters.

Retype Password Re-type the user’s password using all capital, 
alphanumeric characters. Password can only be 10 
characters.
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6. Select the Active option. The system creates a user name using the first 
letter of the first name and the last name. For example, user Tom Smith 
will have a user ID of TSMITH. If a station has two users, Tom Smith and 
a Tim Smith, the second user entered will have the user name of 
TSMITH1.

If the last name is longer than 14 characters, the user name will be 
truncated to that length.

7. Click Save to save the changes.

Or

Click Cancel to return to the main application screen.
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To Manage Existing Station Users
1. Select Administration > Manage Station Users from the main 

application menu. The Manage Station Users screen appears, as shown 
in Figure 46.

TIP: You must 
contact technical 
support in add or 
modify new users 
with the role of 
Station Manager.

Figure 46:  Manage Station Users Screen

2. Clear the Active check box to make a user inactive.

Or

WARNING: Modi-
fying an existing 
user’s first or last 
name will not 
change their user 
ID.

Modify the user’s first or last name.

Or

Modify the user’s password.

3. Click Save to save the changes.

Or

Click Cancel to return to the main application screen.
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Changing User Passwords
A user can modify their own password once they log into the application. If a 
user forgets their password, the station manager must change the password for 
the user. At that time, they can log in and modify the password to something of 
their own choosing. See “To Manage Existing Station Users” on page 107.

To Change a User Password
1. Select Administration > Change Password from the main application 

menu. The Change Password screen appears, as shown in Figure 47.

Figure 47:  Change Password Screen

2. Enter the old password in the Old Password field.

3. Enter the new password in the New Password field.

4. Re-type the new password in the Retype New Password field.

5. Click Save.

The new password will be required the next time the user logs into the 
application.
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10. Third Party Data File Upload
The Pennsylvania e-SAFETY Application provides a web based solution to 
upload safety inspection data that is captured through a process other than the e-
SAFETY Application. This process accommodates stations who have acquired a 
third-party shop application that captures this data. By doing this Pennsylvania 
Department of Transportation (PennDOT) is able to combine data that was 
collected through the e-SAFETY Application or any other third-party application 
into a central repository.

File specifications for this data must be followed by the third-party vendor in 
order to successfully upload data to the central repository.

The following sections is contained within this chapter:

• “Uploading Third Party Data Files”  . . . . . . . . . . . . . . . . . . . . . . .  page 110
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Uploading Third Party Data Files
Stations using third-party applications to collect safety data must use the 
following procedure to upload data files.

To Upload Third Party Data Files
1. Access the application. See “Accessing the Application” on page 14.

2. Select Upload File from the main application menu. The Upload Safety 
Date File screen is displayed, as shown in Figure 48.

Figure 48:  Upload Safety Data Screen

3. Click Browse to navigate to the desired folder.

4. Select the file to be uploaded and click Open.

5. Confirm that the correct file is identified in the File field.

6. Click Upload. The application confirms that the file name is in the 
correct format and that it has not already been uploaded.

WARNING: The 
application veri-
fies that the file is 
named appropri-
ately and has not 
already been 
uploaded. If 
these conditions 
are not met, the 
application dis-
plays and error 
message.

The data file must be formatted in the following convention: 
ssssssss_yyyymmdd_nnn.dat. Where ssss = station number, yyyy = year, 
mm = month, dd = day and n = the sequence number of the file. If an 
invalid filename is uploaded, an error message is displayed. You must 
correct this file name in order to successfully upload this file.

Currently the station number is only a four alphanumeric character. 
However the system will support up to eight alphanumeric characters.

The same file name cannot be uploaded. The sequence number should be 
used to differentiate multiple files for a single date. If a duplicate file 
name is used, an error message is displayed. Do not attempt to upload 
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the same file more than once. If two different files have the same file 
name, you will need to change the sequence number to reflect this 
difference.

7. The application uploads the file and displays a confirmation message, as 
shown in Figure 49.

Figure 49:  Upload Safety Data Screen Displaying Saved Successful Message

8. Repeat this process to upload other files.
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11. Self Enrollment
The Pennsylvania e-SAFETY Application provides functionality for stations to 
self-enroll in PennDOT’s Safety Program. Since the Safety Program is a 
voluntary program, the method of enrollment must be user-friendly and must 
guide the user through the enrollment process.

NOTE: Contact 
the Station Oper-
ator Hotline if you 
are unsure of 
your enrollment 
eligibility.

Stations will be required to enroll online via the enrollment functionality. A 
station must have a valid password, OIS number and a corresponding station ZIP 
code will be allowed access to the online enrollment function.

Enrollment functionality will not allow existing data to be modified by the user. 
Changes to station information and billing information need to be reported 
through appropriate channels. Appropriate customer support contact 
information will be provided in Enrollment Packet. Enrollment Functionality 
user interface will not include specific contact information but will refer user to 
the Enrollment Packet.

The following sections is contained within this chapter:

• “Enrolling in the e-SAFETY Program”  . . . . . . . . . . . . . . . . . . . . .  page 114
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Enrolling in the e-SAFETY Program
Stations wanting to participate in the Pennsylvania e-SAFETY Program must 
first enroll in order to receive login credentials to log in to the application.

To Enroll in the e-SAFETY Program
1. Access the Pennsylvania e-SAFETY Application Enrollment Form by 

typing the URL in the Address field of the Internet browser and press 
Enter.

Contact the Station Operator Hotline if you are unsure of the URL for the 
enrollment page.

2. The enrollment Terms and Conditions page appears. Read through this 
page to determine if you accept these terms and conditions.

NOTE: Be sure to 
thoroughly read 
the terms and 
conditions before 
clicking the 
Accept License 
Agreement but-
ton.

3. Click Accept License Agreement if you agree with these terms and 
conditions. If you do not accept these terms, you will not be able to enroll 
in the e-SAFETY program.

The Enrollment Login screen appears, as shown in Figure 50.

Figure 50:  e-SAFETY Enrollment Login Screen

4. Enter the Password, Station OIS No. and Station Zip Code in the fields 
provided in the Enrollment Login screen.
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NOTE: The Sta-
tion OIS Number 
is the same as 
the Station ID.

Contact the Station Operator Hotline if you are unsure of the password 
and station OIS number. The ZIP Code must correspond with the 
physical address of the station on record.

5. Click OK. The eSafety Enrollment Form appears, as shown in Figure 51.

Figure 51:  e-SAFETY Enrollment Form

The Station Details section will be pre-populated with the associated 
station information. These fields cannot be edited. 

NOTE: If the 
information in the 
pre-populated 
fields is incorrect 
contact the Sta-
tion Operator 
Hotline.

6. Enter the Billing Information. If this information is already filled in, 
skip to the e-SAFETY Manager section in step 7.

The following table provides details about each field:

Field Name Description

Billing Contact Name Name of billing contact.

Alternate Billing Contact Alternate name for the billing contact. This field is 
optional.

Billing Address-Line1-3 The billing address for the station. Three lines are 
provided. Lines 2-3 are optional.

City City of billing address.

Phone Phone number and extension of billing contact.

Phone (Alternate) Phone number and extension of alternate billing 
contact. This field is optional.
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7. Enter the eSafety Manager information. This information is required as 
it indicates who will be responsible for accepting the enrollment 
agreement.

The following table provides details about each field:

8. Click Enroll, once all of the required fields are filled in.

A set of login credentials will be e-mailed to the address identified in the 
eSafety Manager section of the enrollment screen. See “Logging into the 
Application” on page 18 for more information about logging in with these 
credentials.

State The state where the billing address is located.

Zip The ZIP Code the billing address is located.

Zip Plus The four digit numeric code appended to the ZIP 
Code. This field is optional.

Field Name Descriptions

First and Last Name The safety manager’s name. This is the person taking 
responsibility for transaction charges.

Email Address The e-mail address for the safety manager.

Authorized Signature Typed signature of authorized person to enroll in 
eSafety Program.

Date The pre-populated system date that the enrollment 
form is filled out.

Title Title of person completing and signing the enrollment 
form.

Field Name Description
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Active User

A user who has their status currently set as active.

Administrator
See Station Manager.

Barcode
A barcode (also bar code) is a machine-readable representation of informa-
tion in a visual format. Barcodes can be read by optical scanners called bar-
code readers or scanned from an image by special software. Barcodes 
improve the speed and accuracy of computer data entry.

Barcode Reader
A barcode reader (or barcode scanner) is a computer device for reading bar-
codes printed on various surfaces. The reader scans the barcode and inter-
prets the information into readable text.

Bulletins
Informational messages sent to the analyzer machine from Pennsylvania De-
partment of Transportation personnel. These messages can include informa-
tion about software updates, safety recalls and other administrative 
information.

Clerk
See Station Clerk.

Damaged Safety Sticker
A safety sticker that has been damaged and cannot be used. These stickers 
can be entered into the e-SAFETY Application and replacements will be is-
sued to the station. See Stolen Safety Sticker.

e-SAFETY Application
This web-based application is used to gather safety inspection data. This da-
ta will then be used by the Pennsylvania Department of Transportation to an-
alyze trends within safety criteria and look for ways to reduce inspection 
fraud, discover safety equipment repair trends, become more proactive in 
safety recalls, ensure proper inspections and monitor employee and/or con-
tractor performance.

Form MV-431
The inspection report sheet for passenger car, light truck, medium truck, 
heavy truck, bus, school bus, motor home and reconstructed/specially con-
structed.

Form MV-480
The inspection report sheet for motorcycle/motor-driven cycle, moped/motor-
ized pedal-cycle, trailer and reconstructed/specially constructed.
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Inspector
See Technician.

ISP
Internet Service Provider. A company that provides an Internet connection.

Manager
See Station Manager.

MV-431
See Form MV-431.

MV-480
See Form MV-480.

Messages
See Bulletins.

OIS Number
Official Inspection Station. The OIS number is also called the station number.

Password
A password is a form of secret authentication data that is used to control ac-
cess to a resource. The password is kept secret from those not allowed ac-
cess. A user can change their own password at any time, however. the 
password can be reset by the station manager.

Pending Safety Inspection
A safety inspection that has been started, but has not been set to the status 
of complete. The system enables you to start a safety test and save it with 
minimal information and then complete it at a later time.

PennDOT
Pennsylvania Department of Transportation. The government office for the 
state of Pennsylvania that regulates the usage of motor vehicles.

PDF
Portable Document Format (PDF) is a proprietary file format developed by 
Adobe Systems. PDFs can be viewed, searched and printed using Adobe's 
free file viewer. This file type is viewable and printable on any platform — 
Macintosh, Microsoft® Windows®, UNIX® and many mobile platforms.

Registration Card
The PennDOT-issued registration card that provides vehicle and owner infor-
mation. This card includes a barcode that can be scanned to collect this in-
formation in the application.

Safety Inspection
The periodic inspection of a motor vehicle to insure that it is operating safely.
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Safety Inspection Identification Database
The Safety Inspection Identification Database (SIID) used in the Pennsylva-
nia Electronic Emissions Transmission Service to store safety and emission 
data.

Safety Inspection Program
The Pennsylvania Department of Transportation inspection program put in 
place to ensure that vehicles being operated in the state are doing so in a 
safe manner.

SIID
See Safety Inspection Identification Database.

Safety Stickers
A sticker that is issued once a vehicle has passed inspection.

Station Administrator
See Station Manager.

Station Clerk
Safety station personnel who are assigned to enter safety data through the 
e-SAFETY Application.

Station Manager
A person assigned to each station who has administrative rights within the 
application to perform administrative tasks for that station. The tasks include 
adding new users, making existing users inactive and resetting passwords. 
Often this role is granted to the manager of the station. Only one person per 
station can be assigned this role.

Stolen Safety Sticker
Safety stickers that have been removed from possession of the stations with-
out their knowledge.

Technician
The station personnel assigned to perform safety inspections. They are li-
censed by the Pennsylvania Department of Transportation.

URL
A Uniform Resource Locator (URL or, less formally, Web address) is a se-
quence of characters conforming to a standardized format, used for referring 
to resources (such as documents and images on the Internet) by their loca-
tion.

User ID
An alphanumeric user identification that is used to uniquely identify one user 
from another. Generally this value is a first initial and last name (e.g., Tom 
Smith’s User ID would be TSMITH.) This ID is case sensitive.
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VIN
Vehicle Identification Numbers (VINs) are used to uniquely identify motor ve-
hicles. This number consists of 17-21 alphanumeric characters that do not 
include the letters I, O or Q.
- 120 -
Application Solutions

July 9, 2008 1:33 pm TDG



Pennsylvania e-SAFETY Program
e-SAFETY Application User Manual

Doc Ver 5.00 / App Ver 3.07.01
Revision History
The following revisions have been made to the Pennsylvania e-SAFETY Program 
e-SAFETY Application User Manual:

Version Date Change Author

5.00/
3.07.01

5/19/2008 Applied feedback from peer and technical review. 
Versioned for publishing.

TDG

4.01/3.07 5/9/2008 Applied EDD/template version 5.00. Updated content 
for applicaton version 3.07. 

TDG

4.00/3.06 01/18/2008 Versioned to document version 4.00 for production 
release.

TDG

3.04/3.06 01/17/2008 Updated to EDD version 4.00. Also modified manual to 
document various defect fixes fixed in application 
version 3.16.

TDG

3.03/3.04 11/01/2007 Added enrollment Chapter, updated data upload file 
format, modified documentation for various 
applications defect fixes for versions 3.00 - 3.04.

TDG

3.02/2.01 10/31/2007 Applied FrameMaker EDD version 3.00 to the 
document. Also, applied FrameMaker Template version 
4.00.

TDG

3.01/2.01 05/21/2007 Applied FrameMaker template v3.00 with updated 
copyright information.

TDG

3.00/2.01 05/04/2007 Versioned to 3.00 for production release. TDG

2.02/2.01 04/30/2007 Added Chapter and references for uploading third party 
data files. Also corrected various defects identified by 
the Penn Team.

TDG

2.01/2.00 04/09/2007 Added text to License Inspection ID, VIN and Plate No 
fields for inspection entry.

TDG

2.00/2.00 03/27/2007 Applied peer and technical review changes and 
prepared for release.

TDG

1.02/2.00 03/23/2007 Various GUI and bug fixes for pilot release. TDG

1.01/2.00 01/10/2007 Applied FrameMaker EDD version 1.04 to document. 
Updated copyright year.

TDG

1.00/1.00 04/21/2006 First release of user manual. TDG

0.04/1.00 04/04/2006 Submit second version of preliminary copy of manual 
for technical and peer review.

TDG

0.03/1.00 03/16/2006 Submit preliminary copy of manual for technical review. TDG

0.02/1.00 03/03/2006 Started work on documenting the business process of 
the application.

TDG

0.01/1.00 03/01/2006 Create document shell with chapter headings. 
Compiled HTML help to provide development with files 
to link with application.

TDG
- 121 -
Application Solutions

July 9, 2008 1:33 pm TDG



Pennsylvania e-SAFETY Program
e-SAFETY Application User Manual

Doc Ver 5.00 / App Ver 3.07.01
- 122 -
Application Solutions

July 9, 2008 1:33 pm TDG



Pennsylvania e-SAFETY Program
e-SAFETY Application User Manual

Doc Ver 5.00 / App Ver 3.07.01
Index
Numerics
2D scanner, 49

A
Add Station New Users screen, 104
add station users, 104
administration menu, 103
application

exiting, 21
logging in, 18
logging out, 21
starting, 14, 16

B
barcode scanner, 49
button, Keep Pending, 41

C
cancel safety inspection, 50
change

internet cookies, 24
Internet Explorer settings, 22
JavaScripting, 22
user password, 108

Change Password screen, 108
complete safety inspection, 50
conventions

bold text, 9
italic text, 9
menu commands, 9
note, 9
overview, 9
tip, 9
underlined text, 9

cookies, changing, 24
corrected safety stickers, 58
Corrected Safety Stickers screen, 58
cost

grand total, 47
cost, safety stickers, 47

D
damaged safety stickers, 62
definitions, 117
delete

messages, 31
pending work orders, 55

Download button, 74
Download Report screen, 77

E
Enrollment screen, 114
enter safety inspection information, 34
exiting the application, 21
exporting reports, 77

F
File Download Complete screen, 79
File Download screen, 78
File Save As screen, 79
Final button, 50
Finalize Pending Work Orders screen, 53
finalize safety inspection, 50
First button, 73

G
general report information, 72
getting started, 13
glossary, 117
Go To button, 74
grand total cost, 47

H
hardware requirements, 11
Help button, 74

I
identification information, 40
inspection

information, 38
passenger vehicle, 43
safety data, 34

Inspection Report screen, 84
insurance information, 38, 40
internet cookies, changing, 24
Internet Explorer, 19

starting, 14, 16
Internet Explorer settings

changing, 22
internet cookies, 24
JavaScripting, 22

internet options, 19
Internet Options - Settings screen, 20
Internet Options screen, 19

J
JavaScripting, changing, 22
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K
Keep Pending button, 41

L
Last button, 74
launching the application, 14, 16
logging in, 18
logging out of the application, 21
Login screen, 14, 16
login troubleshooting, 26

M
maintain user password, 108
manage station users, 104
Manage Station Users screen, 104
messages

deleting, 31
printing, 30
removing, 31
viewing, 28

missing safety stickers, 60
modify station users, 107

N
navigate safety bulletins, 70
Next button, 74

O
options

internet, 19
Temporary Internet files, 20

owner information, 39

P
Page field, 74
passenger vehicle inspection, 37, 43
password, modify, 108
pending work orders, 51

finalize, 53
keep pending, 52
remove, 55
view, 51

Pending Work Orders screen, 51
PennDOT

bulletins, 69
navigate to bulletins, 70
web site, 69

PennDOT Bulletins screen, 70
PennDOT messages

print, 30
remove, 31
viewing, 28

PennDOT Messages/Bulletins screen, 19, 28
Percentage field, 74
Preview button, 73
print

messages, 30
PennDOT Messages/Bulletins screen, 30
reports, 81

Print button, 74

R
registrant information, 38, 39
registrant, insurance, 38
reload web pages, 19
remove messages, 31
remove pending work orders, 55
Remove Pending Work Orders screen, 55
replacement safety stickers, 62
Replacement Safety Stickers screen, 63
Replacement Sticker Report screen, 89
reports

basics, 72
buttons, 73
export, 77
print, 81
Safety Inspection, 84
Safety Sticker Replacement, 89
save, 77
search criteria, 72
Station Safety Inspection History Detailed Ex-

port, 96
Station Safety Inspection History Summary, 94
Sticker Usage, 101
using, 73
Vehicle Safety Inspection History, 92
view, 72

requirements
hardware, 11
software, 11

S
safety bulletins, 69
safety inspection

cancel, 50
complete, 50
Final button, 50
finalize, 50
passenger vehicle, 37
pending work orders, 51
registrant information, 39
test results, 43
vehicle identification, 40
vehicle insurance, 40
VIN, 40
visual anti-tampering results, 43
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safety inspection data, 34
Safety Inspection report, 84
Safety Inspection screen, 34

inspection information, 38
registrant information, 38
vehicle information, 38
vehicle insurance, 38

Safety Sticker Replacement report, 89
safety stickers

corrected, 58
damaged, 62
information, 47
missing, 60
replace, 62
stolen, 60
void-damaged, 60

sample
generated report screen, 73
search criteria screen, 72

save reports, 77
scanner, barcode, 49
screens

Add New Station Users, 104
Change Password, 108
Corrected Safety Stickers, 58
Download Report, 77
Enrollment, 114
File Download, 78
File Download Complete, 79
File Save As, 79
Finalize Pending Work Orders, 53
Inspection Report, 84
Internet Options, 19
Internet Options - Settings, 20
Login, 14, 16
Manage Station Users, 104
Pending Work Orders, 51
PennDOT Bulletins, 70
PennDOT Messages/Bulletins, 19, 28
Print PennDOT Messages/Bulletins, 30
Remove Pending Work Orders, 55
Replacement Report, 89
Replacement Safety Stickers, 63
Safety Inspection, 34
sample generated report, 73
sample search criteria, 72
Station Inspecion History Report, 94
Sticker Usage Report, 101
Vehicle Safety Inspection Report, 92
Void-Damaged, Stolen, Missing Safety Stick-

ers, 60
Search button, 74
search criteria, reports, 72
software requirements, 11

starting the application, 14, 16
Station Inspection History Report screen, 94
Station Safety Inspection History report, 94
station users

add, 104
modify, 107

sticker maintenance, 57
Sticker Usage report, 101
stolen safety stickers, 60

T
Temporary Internet Files, 20
terminate safety inspection, 50
test results, 43
TOC button, 73
total cost, 47
troubleshooting login, 26
typographic conventions

bold text, 9
italic text, 9
menu commands, 9
note, 9
overview, 9
tip, 9
underlined text, 9

U
users

adding, 104
changing passwords, 108
managing existing, 107
updating, 107

V
vehicle

identification information, 40
vehicle information, 38
vehicle insurance information, 38, 40
Vehicle Safety Inspection History report, 92
Vehicle Safety Inspection Report screen, 92
view messages, 27, 28
view pending work orders, 51
view reports, 72
visual anti-tampering results, 43
void-damaged safety stickers, 60
Void-Damaged, Stolen, Missing Safety Stickers

screen, 60

W
web pages, reloading, 19
work orders, pending, 51
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